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1: Introduction

OptoDataLink™ from Opto 22 is connectivity software for Microsoft® Windows® that collects data from 
Opto 22 SNAP PAC industrial controllers and other sources, and then sends that data to one or more 
destinations. OptoDataLink supports sending data to:
• Databases, including Microsoft SQL Server®, MySQL®, Microsoft Access®, and other ODBC-compliant 

databases
• SNAP PAC controllers and brains
• ASCII text files

Data can be sent to any of these destinations—or all of them—simultaneously. Applications that are well 
suited for OptoDataLink include data archival and data warehousing, as well as those where control system 
alarms need to be reported, acknowledged, and recorded at an enterprise level.

FEATURES

OptoDataLink has several features that make it easy to use:
• As part of Opto 22’s PAC Project Professional™ Software Suite, OptoDataLink is integrated into the 

SNAP PAC System™. OptoDataLink uses the same control system tags (tagnames) used in your 
PAC Control™ strategies. This saves time and effort, since you don’t have to recreate tagnames for 
variables, input/output (I/O) points, or other controller values.

• OptoDataLink uses a graphical user interface to set up data connections. You don’t need to be a database 
expert to configure data links with OptoDataLink.

• Once a data link is established, OptoDataLinkRuntime runs in the background as a Windows service. 
Unless you choose to stop the service, OptoDataLinkRuntime continues to run as long as the computer is 
running. 

OptoDataLink
connectivity software

SNAP PAC controller or brain
Database or other 
enterprise application
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• If your system is set up for redundancy, OptoDataLink automatically recognizes when a strategy includes 
redundant controllers, and includes information about them in the OptoDataLink project. When the 
project runs, OptoDataLink detects when the active controller changes and switches to scanning the 
new active controller.

COMPATIBILITY WITH OPTO 22 PRODUCTS

OptoDataLink collects control data from the following Opto 22 processors, controllers, and brains (I/O 
processors):
• S-series and SNAP PAC R-series programmable automation controllers (PACs), and SoftPAC (Opto 22’s 

PC-based controller).
• EB-series Ethernet brains, with or without a PAC controller.

– When using an EB-series brain with a PAC controller, your OptoDataLink project uses tags from a 
PAC Control strategy (.idb) file.

– When using an EB-series brain without a PAC controller, your OptoDataLink project uses tags from a 
PAC Manager™ configuration (.otg) file.

• SB-series brains connected to SNAP PAC S-series controllers.
• OptoEMU Sensor. For information on reading data from an OptoEMU Sensor, see the OptoEMU Sensor 

Communication Guide (form 1958).

Opto 22 Legacy Products

OptoDataLink can also be used with the older Opto 22 controllers and brains listed below:
• Opto 22 controllers that run control strategies created in ioControl™ programming software, including:

– SNAP-UP1-ADS, SNAP-UP1-M64, and SNAP-UP1-D64 Ultimate controllers.
– SNAP-LCE controller.

• Opto 22 mistic™ M4 series controllers (such as the SNAP-LCM4 and the M4RTU) with an Ethernet 
connection via an M4SENET-100 Ethernet card, and using OptoControl™ firmware R4.1d or newer. 
OptoControl strategy files for these controllers cannot be opened by OptoDataLink; instead, tagname 
information in the form of an OPC Item ID string must be entered manually.

• Opto 22 Ethernet-based brains whose configuration has been saved in a PAC Manager configuration 
(.otg) file. The brain’s configuration information can also be exported from ioControl programming 
software. These brains include:
SNAP-ENET-S64, SNAP-ENET-D64, SNAP-B3000-ENET, SNAP-B3000-ENET-RTC

NOTE: Less control data may be available from these legacy devices than is available from a SNAP PAC controller or 
brain.

COMPATIBLE DATABASES
• Microsoft® SQL Server® 2022, 2019, 2017, 2016, 2014, 2012, 2008, 2005, and 2000
• Microsoft Azure SQL Database
• MySQL® 3.51 and 5.1 (32-bit only)
• Microsoft Access® 2000–2003 and 2007–2016
• Other ODBC-compliant applications (such as Microsoft Excel®, which has a 32-bit ODBC driver)

NOTE: Microsoft has ended support for SQL Server 2005 (and lower) and for Access 2003 (and lower). 
If you’re using applications that Microsoft no longer supports, you should consider upgrading.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4128
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4128
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INSTALLING OPTODATALINK

OptoDataLink is part of the PAC Project™ Software Suite, which you can download from our Opto 22 website 
at www.opto22.com. OptoDataLink is installed by using the PAC Project installer. 

NOTE: OptoDataLink is compatible with Microsoft antivirus software such as Microsoft Defender. However, 
OptoDataLink is not compatible with other third-party antivirus software such as McAfee® AntiVirus Plus™. Before 
installing OptoDataLink, disable or uninstall any third-party antivirus software on the computer that will be running 
OptoDataLink.

1. When you have a password (provided by your Opto 22 Inside Sales representative), download and run 
the PAC Project installer. 

2. When prompted by the installer, select PAC Project Professional. 

3. If you purchased the PAC Project Software Suite, type the password in the PAC Project Professional 
password field. 
If you purchased only OptoDataLink, type the password in the OptoDataLink password field.

To start OptoDataLink:
• In Windows 10, click the Windows Start button, and then click Opto 22 > OptoDataLink 10.2.

Type your PAC Project 
Professional password here
or
type your OptoDataLink 
password here.

http://www.opto22.com/site/downloads/dl_drilldown.aspx?aid=3140
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System Requirements

Computer

• A computer with a standard or mainstream processor and (at least) the minimum memory required for 
your version of Microsoft Windows. (Low-end CPUs are not recommended.) Additional memory may be 
required for some configurations. 

• One of the following operating systems:
– Microsoft® Windows® 10 Professional (32-bit or 64-bit)
– (OptoOPCServer and OptoDataLink only) Windows Server® 2012 R2 and Windows Server 2008 R2

NOTE: PAC Project cannot be installed on Windows XP or older Windows operating systems. Embedded 
operating systems are not tested or supported. 

• Ethernet capability
• VGA or higher resolution monitor. Minimum size: 800x600 with small fonts
• Mouse or other pointing device
• (Optional) Installed Windows printer
• Microsoft .NET Runtime 1.1 or 2.0 (included in the PAC Project Professional installer, or available from the 

Microsoft website)

OptoOPCServer™ Software

If OptoDataLink and other software applications must communicate with the same Opto 22 controller, 
Opto 22 recommends that you use OptoOPCServer software to optimize controller/application 
communications.

For example, OptoOPCServer is useful when Opto 22’s PAC Display HMI software communicates with the 
same controller that OptoDataLink is communicating with. In this situation, only OptoOPCServer 
communicates with the controller; in turn, OptoDataLink, PAC Display, and any other OPC 2.0-compliant 
software applications communicate with OptoOPCServer.

To use OptoOPCServer with OptoDataLink, OptoOPCServer must be installed on the same PC as 
OptoDataLink. OptoOPCServer is included in Opto 22’s PAC Professional software suite, and can also be 
purchased separately.

NOTE: Using OptoDataLink with OptoOPCServer running on another PC is not supported. 

FOR HELP

If you have any questions about OptoDataLink, you can call, email, or fax Opto 22 Product Support. 

Phone: 800-TEK-OPTO 
(800-835-6786 toll-free in the U.S. and Canada)
951-695-3080
Monday through Friday, 
7 a.m. to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

When calling for technical support, you can help us help you faster if you provide the following information to 
the Product Support engineer:
• A screen capture of the Help > About dialog box showing software product and version (available by 

clicking Help > About in the application’s menu bar). 

mailto:support@opto22.com
https://www.opto22.com
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• Opto 22 hardware part numbers or models that you’re working with.
• Firmware version:

– For groov EPIC processors and groov RIO modules: available in groov Manage by clicking Info and 
Help > About.

– For SNAP controllers and brains: available in PAC Manager by clicking Tools > Inspect.
• Specific error messages you received.
• Version of your computer’s operating system.
• For PAC Control, PAC Display, OptoOPCServer, or PAC Manager, you may be requested to provide 

additional information, such as log or dump files. You can find these files in a support files sub-folder:
a. On your Windows Desktop, double-click the PAC Project 10.2 folder.
b. Double-click Support Files.
c. Double-click on the appropriate shortcut to open the sub-folder containing the requested files.

Note: PAC Control, PAC Display, OptoOPCServer, and PAC Manager create appropriate sub-folders when they 
create diagnostic log or dump files. If they have not created these files, the sub-folder may not exist; in this case, 
the shortcut will not work.
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2: OptoDataLink Tutorial

This tutorial shows you how to create an OptoDataLink data link that collects data from a controller and sends 
it to a text file and to a Microsoft Access database file. The tutorial uses the PAC Control™ cookie factory 
example strategy (Cookies.idb) and an example Microsoft Access database (ODL_Access_Example.mdb) that 
is automatically installed when you install OptoDataLink. (You can also download the examples from the 
Opto 22 website.) 

What you need: 
• PAC Control Basic (or PAC Control Professional) and OptoDataLink installed on a PC.
• Access to an Opto 22 controller that:

– Has been upgraded to the most recent PAC firmware release.
To upgrade firmware, see SNAP PAC controllers, the PAC Manager User’s Guide (form 1704).

– Is compatible with PAC Control.
For a list of compatible control engines and I/O units, see the PAC Control User’s Guide (form 1700). 

– Is on the same network as your PC.
• (Optional) To complete the database portion of the tutorial, you need Microsoft Access installed on your 

computer. OptoDataLink supports Microsoft Access versions 2000—2003 and 2007—2013. (For this 
exercise, you don’t need experience using Microsoft Access.)

OptoDataLink User Interface:

Project name

Status 
messages

Menu bar
Toolbar

Choose a 
Data Link 
pane

Browse 
button

Test 
Connection 
button

Configure Data
Link pane

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3165
http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
http://www.opto22.com/site/downloads/
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The tutorial has four parts:
• “Part 1: Download the PAC Control Strategy” on page 8.
• “Part 2: Create a New OptoDataLink Project and Configure the Source” on page 9.
• “Part 3: Send Data to a Text File” on page 11.
• “Part 4: Send Data to a Database” on page 13

PART 1: DOWNLOAD THE PAC CONTROL STRATEGY
In this section, you’ll download an example PAC Control strategy and configure it for use with your controller 
and OptoDataLink.
1. Start PAC Control:
• In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Control Basic 10.2 (or 

PAC Control Pro 10.2).
The PAC Control main window opens.

2. On the PAC Control toolbar, click the Open Strategy button .
3. In the Open Strategy dialog box, browse to 

C:\Users\Public\Documents\Opto 22\PAC Project 10.2\Control Basic Examples\ioCookies. 
(If you’re using PAC Control Pro, substitute “Control Pro Examples” for “Control Basic Examples” in the 
folder location.)

4. Click Cookies.idb to select it, and then click Open to open the strategy in PAC Control.
If a warning message appears saying that the strategy was saved using a lower version of the PAC Control 
database, click Yes to continue.

5. In the PAC Control menu bar, click Configure > Control Engines, and then select your controller. For 
information about configuring control engines and I/O units, see the PAC Control User’s Guide (form 1700).

6. On the PAC Control toolbar, click the Debug mode button .
If message boxes appear prompting you to save or download the strategy, click Yes to continue. 

7. On the PAC Control toolbar, click the Run Strategy button . 
If a message appears asking if you want to start running the strategy, click Start Strategy.

8. To start the flow of data, perform these steps to set bStartFlag:
a. In the Strategy Tree, expand the Numeric Variables folder:

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3165
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9. Double-click the bStartFlag variable.

10. Maximize the Scanning dialog box. In the Value field, type the number 1 to change the value from 0 to 1. 

11. Click Apply and then click the Close button to save your change and close the dialog box.

PART 2: CREATE A NEW OPTODATALINK PROJECT AND CONFIGURE THE SOURCE

In this section, you’ll create an OptoDataLink project and configure a new data link that uses the example 
PAC Control strategy as the source.
1. Start OptoDataLink:
• In Windows 10, click the Windows Start button, and then click Opto 22 > OptoDataLink 10.2.
2. When you start OptoDataLink, a new project opens by default. To save the project:

a. On the OptoDataLink toolbar, click the Save Project button ( ) (or click File > Save on the 
OptoDataLink menu bar).

b. In the Save OptoDataLink Project Configuration File dialog box, navigate to a folder where you want 
to save your project.

c. Type My Project in the File name field, and then click Save to save the project and close the 
dialog box.

3. Rename the new link.
a. In the Choose a Data Link pane, right-click the data link named “newLink.”
b. In the pop-up menu, click Rename. 
c. Type My Data Link and press Enter.

Maximize button

Scanning dialog box

Close button

Type the
new name
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4. Configure Data comes from a:
a. In the “Data comes from a” list, select Opto 22 Device.
b. Click the Add Tags button.
c. In the Open Browse Items File dialog box, browse to 

C:\Users\Public\Documents\Opto 22\PAC Project 10.2\Control Basic Examples\ioCookies. 
(If you’re using PAC Control Pro, substitute “Control Pro Examples” for “Control Basic Examples” in the 
folder location.)

d. Select the Cookies.idb file, and then click Open.
– In the Select tags dialog box, click the check boxes to select the following tags:
– Eu (under I/O Units/Mixed I/O Unit/Indirect/aiDoughVesselPressure)
– StrategyName
– ErrorCount

e. Click Add Tags. Your OptoDataLink window will look something like this:

Select tags

Click Add Tags

Tags to be 
scanned on 
the device
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PART 3: SEND DATA TO A TEXT FILE 

In this section, you’ll use OptoDataLink to create a new text file and configure it as the destination.
1. In the “and goes to” list, select File.

2. In the File name field, type C:\MyTextFile.txt.

TIP: To save a file in the C:\ folder, you must have the necessary permissions for your version of Windows. If you 
cannot save the file in the C:\ folder, try saving it in the My Documents folder.

– If the file does not exist, OptoDataLink creates a blank text file with that name. 
– If the file already exists, OptoDataLinkRuntime will append data to the file during data exchange. 

The path and file name of MyTextFile.txt are displayed in the File field.

3. For this tutorial, don’t change the when or depending on settings. These default settings write data to 
MyTextFile.txt every 10 seconds, as long as the OptoDataLinkRuntime service is running.

and goes to list

Browse button

Add button

when list

depending on list

File name 
field
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4. To start transmitting data to MyTextFile.txt, click Save and Start All Links  in the OptoDataLink toolbar. A 
status message and a green “Active” symbol tell you that the data link is running.

5. To see the data: 
a. In the OptoDataLink toolbar, click Stop All Links  to stop OptoDataLink from logging records while 

you are looking at the file.
b. Start Windows Explorer and browse to the location of MyTextFile.txt:

C:\Users\Public\Documents\Opto 22\PAC Project 10.2\Control Basic Examples\ioCookies. 
(If you’re using PAC Control Pro, substitute “Control Pro Examples” for “Control Basic Examples” in the 
folder location.)

c. Right-click MyTextFile.txt, and in the pop-up menu, click Open. The text file opens, and the data 
looks something like this:

NOTE: When data is sent to a text file, date/time stamps are added automatically to the beginning of each row.

6. To stop data transmission and close OptoDataLink:
a. In the OptoDataLink toolbar, click the Stop All Links button ; or
b. In the OptoDataLink menu bar, click File > Exit.

Congratulations! You have successfully created a link from an Opto 22 device to a text file. 

If you don’t have Microsoft Access installed on your computer, you’re finished with the tutorial.

If Microsoft Access is installed on your computer, you can complete Part 4 to learn how to configure an Access 
table as the destination.

Status messages

Active symbol

Save and Start All Links

Stop All Links
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PART 4: SEND DATA TO A DATABASE

In this section, you’ll send the controller data to a database table in an example Microsoft Access database.
1. To make sure the content in the example is enabled, open the example Access database in Microsoft 

Access:
a. Start Microsoft Access.

• In Windows 10, click the Windows Start button, and then click Microsoft Office > Microsoft Access.
2. In the Access menu bar, click File > Open.

a. In the Open dialog box, browse to
C:\Users\Public\Documents\Opto 22\PAC Project 10.2\OptoDataLink Example

b. Click ODL_Access_Example.mdb to select it, and then click Open.
If a Security Warning appears, click Enable Content.

c. In the left pane, double-click Cookies_Table and scroll to the bottom to find the last record in the 
database table.
Leave Microsoft Access and the database open. You will look at Cookies_Table at the end of Part 4 to 
see your data in the database table. 

3. If OptoDataLink is closed, start it and load My Project.xml (the file you created in Part 2: Create a New 
OptoDataLink Project and Configure the Source).

4. In the Configure Data Link pane, click the Add button. 
You now have two destination sections.

5. In the second “and goes to” list, select Database.
a. In the Product list, select Access.
b. In the Access Version list, select the version of Access on your computer.
c. For the Location:

– Click the Browse button.
– In the Choose Access dialog box, browse to 

C:\Users\Public\Documents\Opto 22\PAC Project 10.2\OptoDataLink Example 

...to create a template 
for a new destination

Click the Add button next to 
an existing destination...
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– Click ODL_Access_Example.mdb to select it, and then click Open.

6. To test the connection between OptoDataLink and the Access database, click Test .

If the connection is not successful, verify:
– Microsoft Access is installed on your computer.
– Your user account has sufficient privileges to use Microsoft Access.
– You selected the correct version of Microsoft Access.

7. For the Table name, type Cookies_Table 

NOTE: There is an underscore ( _ ) between the words “Cookies” and “Table.”

8. For Columns:
a. Click Add Column, and then type Vessel_Pressure
b. Click Add Column, and then type Strategy_Name 
c. Click Add Column, and then type Error_Count
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IMPORTANT: Configure the database column names in the same order as the tags. 

9. Click the Save and Start All Links button  to save the project and start the data link. 
Data is transmitted to both the text file and the Access database.

10. To see the data in the ODL_Access_Example.mdb file:
a. In Microsoft Access’s Tables pane, double-click Cookies_Table.
b. Scroll to the last record. 
The data should look something like this:

!

Notice that the column names don’t appear in the same order as you configured them. That’s OK—as long as 
you configured the tags and column names in the same order, the tags will be copied to the corresponding 
columns.

Congratulations! You have successfully created a data link between an Opto 22 controller and an Access table. 
You can stop the data links, and close both OptoDataLink and Access.

Configure column 
names in the same 
order that you 
configured the tags.
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3: OptoDataLink Basics

In This Chapter

Starting OptoDataLink ...................................................................page 18

Creating, Opening, and Saving Projects.................................page 19

Adding, Renaming, and Deleting Data Links.......................page 20

Starting and Stopping Data Links.............................................page 20

OptoDataLink Error Log.................................................................page 21

OptoDataLink Monitor...................................................................page 23

OptoDataLink provides a graphical user interface to set up and control data links that collect data on a 
scheduled basis, and then transmit the data to other applications or even to other PAC controllers. Data links 
define:
• Sources—The place where the data is coming from.
• Destinations—The place where the data is sent. 
• Conditions—When and how often the data must be collected and transmitted.

A Data comes from an Opto 22 device, a text file, or a database.
B Data link configuration defines the source, destinations, and conditions.
C Data is stored in an Opto 22 device, a text file, or a database.

Data link

Data link

Data link

Project File

Data Data

Source

OptoDataLink

Destination
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Each data link can have only one source, but a data link can have multiple destinations. Sources and 
destinations can be tags in an Opto 22 device, ASCII text files, and ODBC-compliant databases.

To use OptoDataLink, you:
• Create an OptoDataLink project (a way of saving a group of data links).
• Configure data links within the project.
• Run the data links to send data from the source to the destination.

When you run the data links in a project, OptoDataLinkRuntime (a Windows background service) collects the 
data, identifies where each value in the data begins and ends, sends the data to the destination, and handles 
errors. 

Once the data links are running, you can close OptoDataLink and even log off of your Windows user 
account—as long as the computer remains on and all related systems are functioning, OptoDataLinkRuntime 
will collect and transmit the data as defined by the conditions in the project. 

OptoDataLink and OptoDataLink Monitor (an icon displayed in the Windows Notification area) also provide 
visual cues in case OptoDataLinkRuntime stops or fails to start. For details, see “Is the Service running?” on 
page 63.

STARTING OPTODATALINK

To start OptoDataLink: 
• In Windows 10, click the Windows Start button, and then click Opto 22 > OptoDataLink 10.2.

OptoDataLink User Interface

A Menu bar: The menu bar groups the different actions you can perform.

C
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B Toolbar: The toolbar has the following buttons:
 New Project: Start a new project from scratch. (Same as File > New)
 Open Project: Open a different project. (Same as File > Open)
 Save Project: Save the current project. (Same as File > Save)
 Create New Link: Add a data link to the current project. (Same as Edit > Add New Data Link)
 Delete Selected Link: Deletes the selected data link from the current project. (Edit > Delete 
Selected Data Link)

 Save and Start All Links: Saves the current project and starts all links (except those 
configured with "Not Yet" in the "depending on" field). (Same as Run > Start all links.) If a 
project is running, the project and its links are stopped, and the new project is started. 

For information on link status, see “Understanding Link Status Indicators” on page 21.
 Stop All Links: Stops all data links in the current project. (Same as Run > Stop all links)
 Show Error Log: Shows all errors for the configured links. (Same as Run > Show Errors)

C Status Messages: Shows a status summary of the data links—how many are running, how many 
are in error, and how many have been modified. For details, see “Understanding Link Status 
Indicators” on page 21.

D Choose a Data Link pane: Right-click a data link’s name to display a pop-up menu with options to 
rename the link, duplicate the link, and delete the data link.

E Configure Data Link pane: Use the template in this pane to configure the selected data link. For 
details, see “Configuring Databases” on page 25.

F Drop-down lists: Click the drop-down list button to display a list options.

CREATING, OPENING, AND SAVING PROJECTS

When you start OptoDataLink, a new project is automatically created, ready for you to configure and save. If 
you don’t want to create a new project, simply click File > Open and select the project you want. (Exception: If 
you start OptoDataLink from the Monitor, it will load the last project, whether it is currently running or not.)

To create a new project:
• Click the Start New Project button  in the toolbar; or Click File > New in the menu bar.

When you create a new project, the Configure Data Link pane displays a new link for you to configure.

To open an existing project:
1. Click the Open Project button  in the toolbar; or Click File > Open in the menu bar.
2. In the Open OptoDataLink Configuration File dialog box:

a. Browse to the folder that contains the project configuration file (.xml).
b. Click the project to select it, and then click Open.

To save a project:

1. Click the Save Project button in the toolbar; or

Click File > Save in the menu bar.
2. In the Save OptoDataLink Project Configuration File As dialog box:

a. Type a name for the project.
b. Click Save to save the new project and close the file.

TIP: For each project you create, make a list or a screen shot of the data links it contains. 
If you ever need to change a data link, this tip will help you easily find the right project.
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ADDING, RENAMING, AND DELETING DATA LINKS

To add a data link:
• Click the Create New Link button  ; or
• Click Edit > Add New Data Link in the menu bar. 

When you create a data link, a template for configuring a data link appears in the Configure Data Link pane, 
and the name of the data link—by default, named “newLink”—appears in the Choose a Data Link pane.

To change the name of a data link:
1. In the Choose a Data Link pane, right-click the data link.
2. In the pop-up menu, click Rename. 
3. Type a new name, and then press Enter.

To delete a data link:
• In the Choose a Data Link pane, right-click the data link, and then in the pop-up menu, click Delete; or
• Click the data link to select it, and then click Delete Selected Link ; or 
• Click the data link to select it, and then in the menu bar, click Edit > Delete Selected Data Link.

STARTING AND STOPPING DATA LINKS

Once you have started a data link, it will continue to run as long as the computer is running—even if you close 
OptoDataLink and log out of your Windows user account. This is because the OptoDataLinkRuntime service 
(which processes the data links) continues to run in the background until you stop the service or shut down 
the computer.

OptoDataLinkRuntime automatically starts when you start your computer. So if data links are running when 
the computer is shut down, OptoDataLinkRuntime will start the data links automatically when the computer 
boots up. 

NOTE: If a project is running and you start one or more links in a different project, OptoDataLink stops all of the 
running links. 

Create New Link 
button

Choose a Data Link 
pane

Menu bar

Toolbar

Configure Data Link 
pane

Stop All Links button

Save and Start All Links button
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To start all of a project’s data links:
• Click the Save and Start All Links button  in the toolbar; or Click Run > Start all links in the menu bar. 

TIP: If you want to start some of the data links in a project and prevent others from starting, you can set their condition 
to Not Yet. For more information, see “Configuring Conditions” on page 58. 

To stop a project’s data links:
• Click the Stop All Links button  in the toolbar, or 
• Click Run > Stop all links in the menu bar. 

Understanding Link Status Indicators

An icon next to the data link indicates its status.

—The link is running.

(no icon)—If there is no icon, the data link is stopped.

—The link has been modified. Changes have been made since the data link was started.

—An error has occurred. Click the Show Error Log button (in the toolbar) for details.

To monitor data link after you have closed OptoDataLink, see “OptoDataLink Monitor” on page 23.

OPTODATALINK ERROR LOG

The OptoDataLink Errors window displays errors that occur during data exchanges. Error messages are logged 
repeatedly as long as the error persists. 

These messages come from:
• OptoDataLinkRuntime
• OptoDataLink’s scanner
• The databases and Opto 22 devices configured in the project’s data links

Error messages show the name of the data link in error, a description of the error, and the date and time that 
the error was reported.

In addition to configuration-related errors (such as when an incorrect number of Opto 22 device tags are 
configured), data quality messages may also be shown. A data quality message is a text string that is sent from 
the scanner to OptoDataLink. The message includes the value, data quality code, and date/time stamp of the 
error. 

For a list of data quality messages and their descriptions, see “Data Quality Messages” on page 70. 

Status icon



OPTODATALINK ERROR LOG

OptoDataLink User’s Guide22

To open the OptoDataLink Errors window:
• Click the Show Error Log button  in the toolbar; or
• Click Run > Show Errors in the menu bar. 

The OptoDataLink Errors window appears. 

Use the buttons in the OptoDataLink Errors window to:
• Start Windows Event Viewer. 

When you use the Windows Event log button to open Event Viewer, the log records are filtered to show 
only the events logged by OptoDataLink. Be aware that the filtered messages in the OptoDataLink Errors 
window are the same as the messages in Event Viewer. However, you can clear Event Viewer’s filter to see 
if there are other messages to help you troubleshoot issues. 

• Save errors to a file.
• Select the time range when errors occurred. The choices are the past 10 minutes, the past hour, past day, 

past week, or all errors since the data links were started.

To select more than one error, press and hold the Ctrl key, and then use the mouse pointer to click the errors 
you want.

To select all errors, press Ctrl+A. 

To copy the selected errors to the clipboard, press Ctrl+C, or right-click the error and then click Copy in the 
pop-up menu.
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OPTODATALINK MONITOR

OptoDataLink Monitor is a handy tool that helps you easily find out what’s happening with data links when 
you’ve closed or minimized the OptoDataLink window.

OptoDataLink Monitor is installed when you install OptoDataLink. It starts automatically when you start your 
computer and appears in the Windows system tray. (If you don’t see it on the Windows taskbar, click the Show 
hidden icons arrow, and then drag it down to pin it to the taskbar.)

You can also manually start OptoDataLink Monitor:
• In Windows 10, click the Windows Start button, and then click Opto 22 > OptoDataLink Monitor 10.2.

Link Status Indicators

OptoDataLink Monitor displays one of five icons to indicate the status of data links that are running:

—OptoDataLink has started and is evaluating each data link’s current status.

—The OptoDataLinkRuntime service is not running.

—The OptoDataLinkRuntime service is running, but no links are currently transferring data.

—Links are transferring data with no errors.

—One or more links are in an error state.

NOTE: When you start the data links in your project, OptoDataLinkRuntime evaluates the configured sources and 
destinations—even if their conditions are Not Yet (meaning that data is not being exchanged). If something is wrong 
with a data link’s configuration, the data link will have an Error status. This gives you the chance to fix the 
configuration before data is exchanged.

Status Messages

If you hover the mouse pointer over the OptoDataLink Monitor icon, a status message is displayed. 

For a list of status messages and troubleshooting instructions, see Appendix A, “Status Messages from 
OptoDataLink Monitor” on page 69.

Pop-up Menu

Right-clicking OptoDataLink Monitor icon displays a pop-up menu with additional features to help you. Menu 
options are enabled or disabled depending on whether the OptoDataLinkRuntime is running and if any links 
are actively transferring data. 

Show hidden icons arrow

OptoDataLink Monitor
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About.  Displays an About dialog box with the versions and build dates of several important files related to 
current project:

Start OptoDataLink Configurator. Attempts to start OptoDataLink with the currently running project 
loaded. 

NOTE: For this option to work, you must have started the project at least once in OptoDataLink version R9.5a or 
higher. (This updates the project to support this option.) Otherwise, OptoDataLink will start with no project loaded.

View Errors. Displays current OptoDataLink errors. (Same as clicking Run > Show Error Log in the 
OptoDataLink menu bar.)

Start All Links. Attempts to start the data links from the most recent project. 

NOTE: For this option to work, you must have started the project at least once in OptoDataLink version R9.5a or 
higher. (This updates the project to support this option.) 

Stop All Links. Stops currently running links from transferring data. (Same as clicking Run > Stop all links in 
the OptoDataLink menu bar.)

Exit OptoDataLink Monitor. Stops and closes OptoDataLink Monitor.
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4: Configuring Data Links

This chapter is all about configuring sources and destinations—and what you need to know to make them 
work together. If you’re sending data to or from a database, be sure to read “Configuring Databases” on 
page 25.

In This Chapter

Configuring Databases ..................................................................page 25

ASCII Text Files as the Source ......................................................page 31

I/O Points or Variables as the Source .......................................page 33

PAC Control Strategy Tables as the Source............................page 35

SQL Server as the Source ..............................................................page 37

MySQL as the Source......................................................................page 39

Microsoft Access as the Source..................................................page 40

ODBC-Compliant Applications as the Source .....................page 41

ASCII Text Files as the Destination ............................................page 45

I/O Points or Variables as the Destination .............................page 46

PAC Control Strategy Tables as the Destination..................page 48

SQL Server as the Destination ....................................................page 52

MySQL as the Destination ............................................................page 53

Microsoft Access as the Destination........................................page 54

ODBC-Compliant Applications as the Destination ...........page 55

Configuring Conditions .................................................................page 58

CONFIGURING DATABASES
When a database is the source or destination in a data link, there’s some very specific information that 
OptoDataLinkRuntime needs to successfully collect and send data. This may even require creating a new 
database or new database tables.

If you have experience using relational databases, you won’t need any help getting the connection properties 
or creating new databases and tables. But if not, you’re going to need the assistance of a database 
administrator (DBA).
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To help both you and the DBA, here’s a check list of the information you’ll need to configure a database in 
OptoDataLink.

Database Checklist

NOTE: When configuring database table and column names, be aware whether the database is case-sensitive.

Compatible databases are:
• Microsoft® SQL Server® 2022, 2019, 2017, 2016, 2014, 2012, 2008, 2005, and 2000
• Microsoft Azure SQL Database
• MySQL® 3.51 and 5.1 (32-bit only)
• Microsoft Access® 2000–2003 and 2007–2016
• Other ODBC-compliant applications (such as Microsoft Excel®, which has a 32-bit ODBC driver)

NOTE: Microsoft has ended support for SQL Server 2005 (and lower) and for Access 2003 (and lower). 
If you’re using applications that Microsoft no longer supports, you should consider upgrading.

OptoDataLink supports the use of Data Source Names (DSNs), which are logical names used by Open 
Database Connectivity (ODBC) to refer to a driver and other information that the system needs to access data. 
When creating or using a Data Source Name DSN in Microsoft Windows: 

– You must use the 32-bit version of Microsoft’s ODBC Data Source Administrator utility.
To start the ODBC Data Source Administrator utility, press the Windows Start key, and in the Search 
field, type ODBC Data Sources (32-bit). 

– The DSN must be set up as a System DSN—not a User DSN. You configure systems DSNs on the 
System DSN tab in the ODBC Data Source Administrator utility.

• OptoDataLink does not support spaces in database table names or column names. Instead, use a 
different character such as an underscore to make the names readable without using spaces.

• Each column’s data type must match the data type of the data being exchanged. For example, if the 
destination is a float variable in an Opto 22 device, the database column’s data type must support a 
floating-point number. Opto 22 data types are:
– string
– integer 32
– integer 64
– float

• To configure a data link with a database, you need:
SQL Server
– Version (for example, SQL Server 2012)
– Connection (named instance or default instance)

For a named instance, you need:
– DSN name
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For a default instance, you need:
– Server name
– Database name
– Authentication method (Windows authentication or SQL Server authentication)
For Windows authentication, you need:
– User name
– Password

– Table name
– Names of the columns you will be using

NOTE: When typing database object names, don't enter the "dbo." prefix that SQL Server automatically adds. For 
example, if your SQL Server table name is "dbo.Weather," simply enter "Weather" when typing the database table 
name in OptoDataLink.

MySQL
– Version (for example, MySQL 5.1)
– Connection (DSN name, local machine, or network path to MySQL instance)

For DSN, you need the DSN name
If MySQL is located on the local machine or network, you need:
– Database name
– User name

– Table name
– Names of the columns you will be using
Microsoft Access
– Version (for example, Access 2010)
– File path to the Access database

NOTE: Access must be installed on the same computer as OptoDataLink. 
OptoDataLink does not support connecting to Access via a network.

– Table name
– Names of the columns you will be using
ODBC-Compliant Applications

NOTE: Not all ODBC-compliant applications are supported. 
Also, some ODBC drivers do not support accessing a database remotely. 
Refer to the ODBC driver’s documentation to find out if it supports remote access. 
If not, the database must reside on the same computer as OptoDataLink.

– Driver (for example, Microsoft ODBC for Oracle)
– Table name
– Names of the columns you will be using

Databases as the Source

• When the source is a database and the destination is an I/O point or variable:
– For each column in the database, you must configure one I/O point or variable.
– The database table cannot have an auto-numbering primary key column. 

(OptoDataLink checks for a one-to-one relationship between the number of columns and number 
of tags configured.) 

– The database table must consist of only one row. 
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– Each column may be of a different type, as long as the column’s data type matches the data type of 
the corresponding I/O point or variable. For example, if the destination is a float variable, the 
column’s data type must support a floating-point number. 

– The destination tags in the data link must be in same order as the columns in the database table.
Use the Move Up and Move Down buttons to arrange the destination tags in the same order that 
the columns appear in the database table. 
For example, this Access table has four columns:

And here’s how it’s configured in a database-to-I/O-point-or-variable data link:

NOTE: When the source or destination is a SQL Server database object, don't type the "dbo." prefix that SQL Server 
automatically adds. For example, if your SQL Server table name is "dbo.Weather," simply enter "Weather" when 
typing the database table name in OptoDataLink.

• When the data source is a single column in a database table and the destination is an Opto 22 
device table:
– OptoDataLink sends data from database table columns to individual Opto 22 device tables. Each 

column-to-device-table configuration requires its own data link.
For example, your database table has a column of string data, a column of floating-point data, and a 
column of integer data.
– Configure one data link to transmit the string data to an Opto 22 string table.
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– Configure another data link to transmit the floating-point data to an Opto 22 float table.
– Configure another data link to transmit the integer data to an Opto 22 integer table.

– The number of rows in the database table must match the number of elements in the destination 
device table.

–  To specify the source column, use the syntax <table name>. <column name>.
For example: Weather.City

NOTE: When the source or destination is a SQL Server database object, don't type the "dbo." prefix that SQL Server 
automatically adds. For example, if your SQL Server table name is "dbo.Weather," simply enter "Weather" when 
typing the database table name in OptoDataLink.

• When the data source is all columns of a row in a database table and the destination is an 
Opto 22 device table:
– After each configured time interval, OptoDataLink sends data from one row in the database table to 

the specified Opto 22 device table.
To accomplish this, your database table must have one column for each element in the Opto 22 
device table.
For example, if your device table has 10 elements, the database table must have 10 columns. 

– OptoDataLink can copy data to an entire device table or to only a range of elements. Just remember:
– The number of columns must match the number of elements in the table (or range).
– The data from the database columns is copied in order to the elements in the table (or range). 

For example, if the destination is Index 4 through 6, Index 4 gets the value in the first database 
column, Index 5 gets the value in the second database column, and Index 6 gets the value in 
the last database column. 

– Each database column type (integer, float, string) must match the type of your device table (integer 
table, float table, string table). 

– OptoDataLink cycles through the rows of your database table, and sends one row of values to your 
device table at each configured time interval.

– To specify the source database table, simply type the table name (no column names). 
For example: Weather

Databases as the Destination

If you aren’t experienced using databases, see “Configuring Databases” on page 25.

If you are experienced using databases, or you have the information described in “Configuring Databases,” 
keep reading.

NOTE: Opto 22 recommends you set a default value (for example, NULL) for each column in a destination 
database. Otherwise, during a data transfer, your database may report an error if there isn’t valid data to be inserted 
into that column at that time. This is because OptoDataLink generates an INSERT INTO command only for the 
columns that have valid data. (Invalid data can be caused by several issues. For more information, see Opto 22 
KnowledgeBase article KB82887, OptoDataLink won't log any data for a link that has an invalid tag or IP address.)

https://www.opto22.com/support/resources-tools/knowledgebase/kb82887
https://www.opto22.com/support/resources-tools/knowledgebase/kb82887
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When the destination is a database:
• Each value’s data type (string, integer, or float) must match the data type of its assigned column.
• For each value in a line of data, configure a separate database column. (You can’t send two different 

values to the same column.) 
Configure the columns in the same order that the values appear in the source. 
For example, if a record in the source contains values for City, Temperature, and Humidity, then configure 
their corresponding destination columns in the same order.
Use the Move Up and Move Down buttons to change the configured order of the columns. The order of 
the columns in the database doesn’t matter—what matters is that the order of the values in the source 
matches the order in which you configure the columns in OptoDataLink.

With each data exchange, one record of source data is sent to a row in the database table. When the last 
record of source data is reached, OptoDataLinkRuntime starts over by sending the first record of source data, 
and then the next record, and so forth. The cycle repeats as long as OptoDataLinkRuntime is running.

When the source is a table in a PAC Control strategy and the destination is a database:

OptoDataLinkRuntime creates a separate record for each element in the strategy table, and writes the 
following data (in this order) to the destination:
• Date/Time Stamp—The date and time that the source data was written to the destination.
• Index—The index number of the source data in the strategy table.
• Data—The value of the source data in the given index number.
• Unique Id—(Optional) A unique identifier for the value of the source data.

You must configure a database table column for Date/Time Stamp, Index, and Data. If you select the Send 
Unique Id check box in OptoDataLink, you must also configure a column for Unique Id.

NOTE: If you did not select the Send Unique Id check box, click the Delete button to delete the column from your 
configuration. 

When configuring destination database table columns for these data items, the column’s data type must be 
compatible with the data type of the data item.

– For the Date/Time Stamp column, the column’s data type can be:
– Either text or datetime in SQL Server.
– Either text or date/time in Microsoft Access.
– Either text or datetime in MySQL. 

– For the Index column, the column’s data type must be an integer.
– For the Data column, the column’s data type must be equivalent to the data type of the strategy 

table (which can be a string, an integer, or a float). 
– For the Unique Id column, the column’s data type must be an integer. Note that the Unique Id is 

transmitted only if the Send Unique Id check box is selected.

NOTE: When the source or destination is a SQL Server database object, don't type the "dbo." prefix that SQL Server 
automatically adds. For example, if your SQL Server table name is "dbo.Weather," simply enter "Weather" when 
typing the database table name in OptoDataLink.

The order of the columns in the database table doesn’t matter. What’s important is that, in the destination 
configuration, the first column is for the date/time stamp data, the second column is for the table index, the 
third column is for the table value, and the fourth column is for the unique Id. 
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For example, if you configure your source like this:

...then configure a destination table like this: 

A Type the name of the destination database table.
B Type the name of the column to store the date/time stamp. 

– For SQL Server databases, this column’s data type must be Text or DATETIME.
– For Microsoft Access databases, this column’s data type must be Text or DATE/TIME.
– For MySQL databases, this column’s data type must be Text or DATETIME.

C Type the name of the column to store the index number from the strategy table.
– This column’s data type must be an integer.

D Type the name of the column to store the data values from the strategy table.
– This column’s data type must match the data type of the strategy table. 

E If you selected the Send Unique Id check box, type the name of the column to store the ID.
– This column’s data type must be an integer.
If you did not select Send Unique Id, use the Delete button to delete this column.

ASCII TEXT FILES AS THE SOURCE

When an ASCII text file is the source:
• OptoDataLink and the text file must be on the same computer. OptoDataLink cannot read from or write 

to remote text files. 
• OptoDataLinkRuntime identifies:

– The end of a value by a comma or space delimiter.
– The beginning of a new record by the ASCII characters for CRLF (which is the equivalent of pressing 

the Enter key in the text file).
For details, see “About Text Files” on page 32.

To configure a text file as the destination, see page 45.

Select this option to send the 
ID number from the strategy 
table to the database table.

Select this option to overwrite 
the data in the database table 
with each data exchange.

C
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To configure a text file as the source:
1. In the “Data comes from a” drop-down list, select File.
2. Click Browse, and then browse to the folder containing the source text file.
3. In the Choose file for source dialog box, click the file to select it, and then click Open.

About Text Files

A text file is an easy and simple way to transfer data to tags in an Opto 22 device. Text files can contain 
numeric data (for example, integers like 612 and floating point numbers like 98.6), string data (that is, 
alphanumerics like Conference Room 4), or a combination of numerics and strings.

When using a text file as the source, keep these rules in mind:
• Text files must be in ASCII format; Unicode text files are not supported.
• Text files must be on the same computer as OptoDataLink. OptoDataLink cannot read or write to remote 

text files.
• Text files can contain only static data. You can’t use a text file to send, for example, a pointer or a function. 
• Text files consist of records and values. Values are the data itself. Records are a set of associated values. 

Records are sometimes called rows. 
• When you press the Enter key in a text file, invisible ASCII control characters (namely, CRLF) are inserted 

into the file. OptoDataLinkRuntime identifies CRLF as the beginning of a new record. It's alright if the 
record has so many characters that they "wrap around" to the next line in the text file—OptoDataLink 
doesn’t mark the beginning of a new record until it reads CRLF.

• In a text file, you use a delimiter to separate the values in a record. With OptoDataLink you can use either a 
comma or a space as the delimiter in a text file:

Space Delimiters.  When you use spaces as the delimiter, each value in the text file is evaluated as a string. 
For example, the value “4” in a space-delimited text file is not considered a number; it’s stored as a 
one-character string. 

If you’re using space delimiters, don’t use a space when a string has more than one word. Instead, use a 
different character such as an underscore to make the words readable without using spaces. For example, 
instead of Conference Room 4 , write the value like this: Conference_Room_4

Comma Delimiters.  Comma delimiters take precedence over spaces. When a file containing only 
strings includes both spaces and commas, OptoDataLink separates each item of data when it finds a comma.

If the text file contains: Use this as the delimiter:

numeric data only commas

numeric and string data commas

string data only commas or spaces

“Data comes from a” 
list

Browse button
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For example, OptoDataLink interprets this string:

Areas 22, 30, and 31 

...as three separate strings—like this:

Areas 22
30
and 31 

Notice that OptoDataLink retains the spaces before 30 and and 31.

To avoid problems when the source data includes commas, replace commas within the source data with a 
different character. Otherwise, OptoDataLinkRuntime will treat data following the comma as a new string. 

For example, to make sure Areas 22, 30, and 31 remains as one record, replace the commas with 
semicolons, and put a comma after and 31 to designate the end of the record: 
Areas 22; 30; and 31,

To configure destinations, see:
• “ASCII Text Files as the Destination” on page 45
• “I/O Points or Variables as the Destination” on page 46
• “PAC Control Strategy Tables as the Destination” on page 48
• “Databases as the Destination” on page 29

– “SQL Server as the Destination” on page 52
– “MySQL as the Destination” on page 53
– “Microsoft Access as the Destination” on page 54
– “ODBC-Compliant Applications as the Destination” on page 55

To configure conditions, see page 58.

I/O POINTS OR VARIABLES AS THE SOURCE

NOTE: If the source is an Opto 22 strategy table, see page 35.

Select Opto 22 Device as the source to get data from an I/O point or variable in an Opto 22 device. 
OptoDataLink supports numeric (32-bit integer, 64-bit integer, and float), string, and pointer variables.
• If you are using PAC Control or ioControl, you can choose tags from a strategy (.idb) file.
• If you are using an Ethernet-based OptoControl controller, and you know the required OPC connection 

information, you can enter a tag value manually in the form of an OPC communication string. 

Create New Link button

If the project has more 
than one data link, click 
the link to configure

“Data comes from a” list

Add Tags button

Communication strings include the controller’s 
IP address and the source tagnames.

Delete tag

Move tag up

Move tag down

Click Details to set the heartbeat 
interval.

Click here and type the 
communication string to 
manually add a tag.
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To configure I/O points or variables as the source:
1. In the “Data comes from a” list, select Opto 22 device.
2. Click Add Tags.
3. In the Open Browser Items File dialog box, locate the folder that contains the .idb or .otg file you want. 
4. Click the file to select it, and then click Open.

The Select tags window opens.
5. In the Select tags window, select each tag you want, and then click Add Tags.

If you have a choice between an I/O tag in a Direct folder and a tag in an Indirect folder for an I/O unit, 
you should normally choose the tag in the Direct folder, because it has a direct connection to the I/O unit 
and is faster. 
An indirect connection goes through the controller, which slows down the connection. However, there 
may be times when you have to choose a tag in the Indirect folder, such as:
– When the I/O unit is a serial brain.
– When the network that connects the controller and your computer is different from the network 

that the I/O unit is on.

To reorder or delete items, use the Move Up, Move Down, and Delete buttons.

To add a tag manually:
1. Click in the empty field at the bottom of the Write to data items list.
2. Type the appropriate communication string, and then press Enter. 

You can also edit items in the list by making manual changes to the communication string.

To change how often OptoDataLink checks the scanner:
1. Click Details.
2. Enter a new value for the heartbeat interval.
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3. Click Save to close the OPC Details dialog box.

To configure destinations, see:
• “ASCII Text Files as the Destination” on page 45
• “I/O Points or Variables as the Destination” on page 46
• “PAC Control Strategy Tables as the Destination” on page 48
• “Databases as the Destination” on page 29

– “SQL Server as the Destination” on page 52
– “MySQL as the Destination” on page 53
– “Microsoft Access as the Destination” on page 54
– “ODBC-Compliant Applications as the Destination” on page 55

To configure conditions, see page 58.

PAC CONTROL STRATEGY TABLES AS THE SOURCE

NOTE: If the source is an I/O point or a variable, see “I/O Points or Variables as the Source” on page 33.

To use a numeric or string table in a PAC Control strategy as the source, select Opto 22 Device Table in the 
“Data comes from a” list. (OptoDataLink does not support pointer tables.)
• The strategy table’s data type (string, 32-bit integer, 64-bit integer, or float) must match the data type of 

the corresponding destination.
• With every data exchange, OptoDataLink creates a separate record for each element in the strategy table, 

and writes the following data (in this order) to the destination: 
– Date/Time Stamp—The date and time that the source data was written to the destination.
– Index—The index number of the source data in the strategy table.
– Data—The value of the source data in the given index number.
– Unique Id—(Optional) A unique identifier for the value of the source data.

• By default, data is appended to the destination. To overwrite the data in the destination (ensuring that 
the destination shows only the newest information), select the Single Sample option. 

Heartbeat interval
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To configure a strategy table as the source: 
1. In the “Data comes from a” drop-down list, select Opto 22 Device Table, and then click Edit.
2. In the Open Browser Items File dialog box, browse to the .idb file for the strategy that is running on the 

Opto 22 device. 
3. Double-click the .idb file to select it, and then click Open.

The Select tag window opens.
4. In the Select tag window, expand the folders until you find the strategy table you want.

5. Click the strategy table to select it, and then click Add Tag. The Select tag window closes.

NOTE: By default, OptoDataLink selects all of the elements in the strategy table. To change the range of 
elements, click the source to select it, and then manually type the start and end elements. 
(The range of elements must be consecutive; for example [4-16].)

6. (Optional) Select output options for the data. 

“Data comes from a” list

Create New Link 
button

If the project has 
more than one data 
link, click the link to 
configure

To change the range of source data, 
replace the default start and end 
range with the range you want. 
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– Single Sample. (Not applicable to Excel workbook files. Excel always appends data.) Select this option 
for OptoDataLink to overwrite the data in the destination file or database table with each data 
exchange. This way, only the most recent values of table data are stored in the destination file or 
database table. 
Don’t select Single Sample if you want to append data to the destination file or database table. 

NOTE: If you have been using OptoConnect and are upgrading to OptoDataLink, select the Single Sample check 
box. This allows you to keep your existing databases and maintain backwards compatibility.

– Send Unique Id. Select this option for OptoDataLink to log a unique identifier for each new row of 
data. 

To configure destinations, see:
• “ASCII Text Files as the Destination” on page 45
• “I/O Points or Variables as the Destination” on page 46
• “PAC Control Strategy Tables as the Destination” on page 48
• “Databases as the Destination” on page 29

– “SQL Server as the Destination” on page 52
– “MySQL as the Destination” on page 53
– “Microsoft Access as the Destination” on page 54
– “ODBC-Compliant Applications as the Destination” on page 55

To configure conditions, see page 58.

SQL SERVER AS THE SOURCE

If you have the information described in “Configuring Databases” on page 25, keep reading.

To configure SQL Server as the source:
1. In the “Data comes from a” list, select Database.
2. In the Database Product list, select your version of SQL Server.
3. If you have a Data Source Name (DSN), follow the instructions for D, E, F, and G.

If your connection is a default instance or a named instance, follow the instructions 
for A, B, C, E, F, and G.
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A Server Location: If your database is a default instance, type the server location. 
If your database is a named instance, type the server name and the named instance separated by a 
backslash. Example: servername\instancename
If you are using the SQL Server Express, type the server name and the database name separated by a 
backslash. Example: servername\SQLEXPRESS

B Database Name: Type the database name. For example, Weather

NOTE: When the source or destination is a SQL Server database object, don't type the "dbo." prefix that SQL 
Server automatically adds. For example, if your SQL Server table name is "dbo.Weather," simply enter 
"Weather" when typing the database table name in OptoDataLink.

C User Login / Windows Security: If your database uses SQL Server authentication, type the database 
username and password.
If your database uses Windows authentication, select Windows Security.

D Data Source Name: Select Data Source Name, and then select the DSN from the list.
E Test Database Connection button: When you click this button, OptoDataLink attempts to connect 

to the database using the connection settings you selected. This button does not test the table name 
or the order by column setting.

F Table Name: Type the name of the database table. The table name cannot include spaces.
If the database table has only one column of data, you can simply type the database table name.
If the database table has more than one column, type the database table name, a period (as a 
separator), and the column name. 
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

G (Optional) Order by Column: To send the returned data in ascending order, type the column name.
For example, type CITY in the Order by Column field to send the data (in the table below) in 
alphabetical order by city. The rows in the table below are sent to the destination in this order:
– AUSTIN,68,1,RAIN
– BENSALEM,48,.28,SUNNY
– DENVER,65,.21,CLOUDY
– SAN DIEGO,69,.77,SUNNY

To configure destinations, see:
• “ASCII Text Files as the Destination” on page 45
• “I/O Points or Variables as the Destination” on page 46
• “PAC Control Strategy Tables as the Destination” on page 48
• “Databases as the Destination” on page 29

– “SQL Server as the Destination” on page 52
– “MySQL as the Destination” on page 53
– “Microsoft Access as the Destination” on page 54
– “ODBC-Compliant Applications as the Destination” on page 55

To configure conditions, see page 58.

CITY TEMP_F HUMIDITY FORECAST

SAN DIEGO 69 .77 SUNNY

BENSALEM 48 .28 SUNNY

DENVER 65 .21 CLOUDY

AUSTIN 68 1 RAIN



OptoDataLink User’s Guide 39

MYSQL AS THE SOURCE

If you have the information described in “Configuring Databases” on page 25, keep reading.

To configure MySQL as the source:
1. In the “Data comes from a” list, select Database.
2. In the Database Product list, select MySQL.
3. In the MySQL Version field, select your version of MySQL.
4. If your connection is via a network or local computer, follow the instructions for A, B, C, E, F, and 

(optionally) G.
If your connection is a DSN, follow the instructions for D, F, and (optionally) G. 

A Server: If the database is on a local drive, select This Computer. If the database is on a network, type 
the file path to the database.

B Database: Type the database name. For example, Weather
C Database User and Password: Type the database user name and password.
D Data Source Name: Select Data Source Name, and then select the DSN from the list.
E Test Database Connection button: When you click this button, OptoDataLink attempts to connect 

to the database using the connection settings you selected. This button does not test the table name 
or the order by column setting.

F Table Name: Type the name of the database table. The table name cannot include spaces.
If the database table has only one column of data, you can simply type the database table name.
If the database table has more than one column, type the database table name, a period (as a 
separator), and the column name. 
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

G (Optional) Order by Column: To send the returned data in ascending order, type the column name. 
For example, type CITY in the Order by Column field to send the data (in the table below) in 
alphabetical order by city. The rows in the table below are sent to the destination in this order:
– AUSTIN,68,1,RAIN
– BENSALEM,48,.28,SUNNY 
– DENVER,65,.21,CLOUDY
– SAN DIEGO,69,.77,SUNNY
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To configure destinations, see:
• “ASCII Text Files as the Destination” on page 45
• “I/O Points or Variables as the Destination” on page 46
• “PAC Control Strategy Tables as the Destination” on page 48
• “Databases as the Destination” on page 29

– “SQL Server as the Destination” on page 52
– “MySQL as the Destination” on page 53
– “Microsoft Access as the Destination” on page 54
– “ODBC-Compliant Applications as the Destination” on page 55

To configure conditions, see page 58.

MICROSOFT ACCESS AS THE SOURCE

If you have the information described in “Configuring Databases” on page 25, keep reading.

When an Access database is the source or destination, OptoDataLink and the database must be on the same 
computer. (OptoDataLink cannot read from or write to remote Microsoft Access databases.)

Access table names and column names are not case-sensitive. For example, you can configure the table name 
in a data link as Weather.accdb or weather.accdb.

To configure Microsoft Access as the source:
1. In the “Data comes from a” list, select Database.
2. In the Database Product list, select Access.
3. In the Access Version list, select your version of Access.
4. Follow the instructions for A, B, C, and (optionally) D.

A Database Location: Click the Browse button to locate the Access database folder. Then select the 
database and click Open.

CITY TEMP_F HUMIDITY FORECAST

SAN DIEGO 69 .77 SUNNY

BENSALEM 48 .28 SUNNY

DENVER 65 .21 CLOUDY

AUSTIN 68 1 RAIN
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B Test Database Connection button: When you click this button, OptoDataLink attempts to connect 
to the database using the connection settings you selected. This button does not test the table name 
or the order by column setting.

C Table Name: Type the name of the database table. The table name cannot include spaces.
If the database table has only one column of data, you can simply type the database table name.
If the database table has more than one column, type the database table name, a period (as a 
separator), and the column name. 
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

D (Optional) Order by Column: To send the returned data in ascending order, type the column name. 
For example, type CITY in the Order by Column field to send the data (in the table below) in 
alphabetical order by city. The rows in the table below are sent to the destination in this order:
– AUSTIN,68,1,RAIN
– BENSALEM,48,.28,SUNNY 
– DENVER,65,.21,CLOUDY
– SAN DIEGO,69,.77,SUNNY

To configure destinations, see:
• “ASCII Text Files as the Destination” on page 45
• “I/O Points or Variables as the Destination” on page 46
• “PAC Control Strategy Tables as the Destination” on page 48
• “Databases as the Destination” on page 29

– “SQL Server as the Destination” on page 52
– “MySQL as the Destination” on page 53
– “Microsoft Access as the Destination” on page 54
– “ODBC-Compliant Applications as the Destination” on page 55

To configure conditions, see page 58.

ODBC-COMPLIANT APPLICATIONS AS THE SOURCE

If you have the information described in “Configuring Databases” on page 25, keep reading.

When you select ODBC Databases from the Database Product list, OptoDataLink reads the list of ODBC drivers 
from the Microsoft ODBC Data Source Administrator utility, and then displays them in the Drivers drop-down 
list.

After you select the driver for your database, you click the Configure Driver button. Depending on the driver 
you selected, OptoDataLink prompts you for the data it needs to build a connection string to the database.

OptoDataLink supports some—but not all—remote ODBC-compliant applications. (A remote application is 
one that is not on the same computer as OptoDataLink.) To determine if your ODBC-compliant application 
can be accessed remotely, see the ODBC driver’s documentation or contact the provider. 

For an example that configures Microsoft Excel’s ODBC driver in a data link, see page 43.

CITY TEMP_F HUMIDITY FORECAST
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To configure an ODBC-compliant application as the source:
1. In the “Data comes from a” list, select Database.
2. In the Database Product list, select ODBC databases.
3. In the Driver list, select the driver for the database you’re using, and then click Configure Driver.

OptoDataLink prompts you for the information it needs (such as the server location or file path, and login 
credentials) to construct a connection string to the database. If necessary, you can edit the connection 
string.

4. Click the Test button to see if OptoDataLink can to connect to the database.
5. In the Table Name field, type the name of the database table. The table name cannot include spaces.

If the database table has only one column of data, you can simply type the database table name.
If the database table has more than one column, type the database table name, a period (as a separator), 
and the column name.
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

6. (Optional) In the Order by Column field, type a column name to send data in ascending order, based on 
the data in that column.
For example, type CITY in the Order by Column field to send the data (in the table below) in 
alphabetical order by city. The rows in the table below are sent to the destination in this order:

– AUSTIN,68,1,RAIN
– BENSALEM,48,.28,SUNNY 
– DENVER,65,.21,CLOUDY
– SAN DIEGO,69,.77,SUNNY

To configure destinations, see:
• “ASCII Text Files as the Destination” on page 45
• “I/O Points or Variables as the Destination” on page 46
• “PAC Control Strategy Tables as the Destination” on page 48
• “Databases as the Destination” on page 29

– “SQL Server as the Destination” on page 52
– “MySQL as the Destination” on page 53

CITY TEMP_F HUMIDITY FORECAST
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– “Microsoft Access as the Destination” on page 54
– “ODBC-Compliant Applications as the Destination” on page 55

To configure conditions, see page 58.

ODBC Example: Excel as the Source

The following steps use Excel and its ODBC driver as an ODBC-compliant data source.

Steps in Excel:
1. Start Excel, and open the workbook that contains the data you want to send.
2. Configure a named region that contains the column names and data to send. Excel treats the first record 

as a header and does not include it in the data exchange. 
Note that the column names cannot contain spaces. 
a. Right-click the selection, and then click Define Name to open the New Name dialog box.
b. In the Name field, type the name.
c. In the Scope field, select Workbook.

d. Click OK to close the New Name dialog box.
3. If you have Excel 2010 or higher, click the Review tab and then Share Workbook to make the workbook 

accessible to the ODBC driver. If a Microsoft privacy error is displayed, follow the instructions in the 
message to disable privacy for the workbook. 

4. Save and close the workbook.

Steps in OptoDataLink:
1. Start OptoDataLink, create a new data link, and in the “Data comes from a” list, select Database.
2. In the Database Product list, select ODBC databases.
3. In the Driver list, select a Microsoft Excel driver. If there is more than one Excel driver, choose the driver for 

the version of Excel you are using. In this example, we’re using Excel 2010, so we select Microsoft Excel 
Driver (*.xls, *.xlsx, *.xlsm, *.xlsb).
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4. Click Configure Driver. Select the version of Excel you are using (for example, Excel 2010 is version 12.0), 
and then click Select Workbook.

5. In the Select Workbook dialog box, browse to the workbook and select it.

NOTE: Be sure that Read-Only is not selected. Otherwise, OptoDataLink can’t write data to the file.

6. Click OK to close the Select Workbook dialog box, and then click OK to close the ODBC Microsoft Excel 
dialog box. 

7. Click the Test button to see if OptoDataLink can to connect to the workbook.
8. In the Table Name field, type the named region. 
9. To sort the data, type a column name in the Order by Column field.by 
10. Configure a destination and then run the data link.

In this example, our configured data link looks like this:

Select the 
version

Click Select 
Workbook

Select the file

Unselect 
Read Only
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And our text file destination looks like this:

ASCII TEXT FILES AS THE DESTINATION

When an ASCII text file is the destination:
• OptoDataLink and the text file must be on the same computer. OptoDataLink cannot read from or write 

to remote text files. 
• OptoDataLinkRuntime identifies:

– The end of a value by a comma or space delimiter.
– The beginning of a new record by the ASCII characters for CRLF (which is the equivalent of pressing 

the Enter key in the text file).
For details, see “About Text Files” on page 32.

• OptoDataLink appends new records to the end of the data in the destination text file. (Exception: If you 
selected Single Sample in data output options, data will be overwritten.) Data in the destination file is 
stored as string data; each value is enclosed by single quotes ( ' ' ) and values are comma-delimited. 
Also, OptoDataLinkRuntime appends the current date/time stamp to each record in the destination file 
(to shows when the record was written to the destination).

• Each destination text file must have a unique file name. OptoDataLink displays an error if you try to 
configure the same text file more than once as a destination.

• When the source is an I/O point or a variable, you can send the same tag to a destination twice by 
selecting the tag twice in the source configuration.

To configure an ASCII text file as the destination:
1. In the “and goes to a” drop-down list, select File.
2. Click Browse, and then browse to the folder containing the destination text file.
3. In the Choose file for sink dialog box, click the file to select it, and then click Open.

TIP: You can create a text file on the fly. In the File field, type a path and file name with the extension .txt (for 
example: C:\Pressure_Readings.txt ). 

– If the file does not exist, OptoDataLink creates a blank text file with that name. 
– If the file already exists, OptoDataLinkRuntime will append data to the file during the data exchange.

4. If you want a new file created periodically (hour or day), specify the period in Rollover Every. For example, 
if you want a new file created every hour, type 1 in the Rollover Every field, then select Hours in the list 
next to it.
The format of the file name is <output file name>_YYYYMMDDHHHH.<extension>
If you select Hour, the new file is created at the beginning of each hour, regardless of when you start the 
link. If you select Days, the new file is created at midnight of each day, regardless of when you start the 
link.
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This image shows an example configuration for a text file destination:

This image shows the example output:

I/O POINTS OR VARIABLES AS THE DESTINATION

NOTE: If the destination is an Opto 22 strategy table, see page 48.

When the destination consists of I/O points or variables in an Opto 22 device:
• For each value in a record of source data, configure a corresponding destination tag. For example, if a 

record in the source contains three values, configure three tags in the destination.
• Configure the destination tags in the same order as the values in the source. If necessary, use the Move 

Up and Move Down buttons to change the order of the tags.
• The data types of the source data must match the data type of its assigned tag. (In other words, send 

string data to string tags, float data to float tags, 32-bit integer data to 32-bit integer tags, and 64-bit 
integer data to 64-bit integer tags.)

• If you are using PAC Control or ioControl, you can choose tags a from a strategy (.idb) file or from an I/O 
configuration file (.otg). 

• If you are using Ethernet-based OptoControl controller, and you know the required OPC connection 
information, you can enter a tag value manually in the form of an OPC communication string. 

To configure I/O points or variables as the destination:
1. In the “and goes to” list, select Opto 22 device.
2. Click Add Tags.
3. In the Open Browser Items File dialog box, locate the folder that contains the .idb or .otg file you want. 
4. Click the file to select it, and then click Open.

The Select tags window opens.

“and goes to” list

Browse button

There were two blank values in the 
source data, and here they are in 
the destination.

In this example, the link continues 
writing data to the same tags. 
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5. In the Select tags window, select each tag you want, and then click Add Tags.

If you have a choice between an I/O tag in a Direct folder and a tag in an Indirect folder for an I/O unit, 
you should normally choose the tag in the Direct folder, because it has a direct connection to the I/O unit 
and is faster. 
An indirect connection goes through the controller, which slows down the connection. However, there 
may be times when you have to choose a tag in the Indirect folder, such as:
– When the I/O unit is a serial brain.
– When the network that connects the controller and your computer is different from the network 

that the I/O unit is on.

This image shows an example of variables in a strategy being used as the destination:

Click Details to set the 
heartbeat interval.

 Move tag up

 Delete tag

 Move tag 
down

Communication strings include the destination's IP 
address, port number, data type, and tagname. “CONT” 
indicates that the data comes from the controller 
(indirect). “MMIO” indicates that the data comes directly 
from the I/O unit. 

To manually add a tag, click 
here and type the 
communication string.

“Write to data 
items” list

Add tags button
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...And this image shows the example output:

To reorder or delete items, use the Move Up, Move Down, and Delete buttons.

To add a tag manually:
1. Click in the empty field at the bottom of the Write to data items list.
2. Type the appropriate communication string, and then press Enter. 

You can also edit items in the list by making manual changes to the communication string.

To change how often OptoDataLink checks the scanner:
1. Click Details.
2. Enter a new value for the heartbeat interval.

3. Click Save to close the OPC Details dialog box.

PAC CONTROL STRATEGY TABLES AS THE DESTINATION

NOTE: If the destination is an I/O point or a variable in another Opto 22 device, see “I/O Points or Variables as 
the Destination” on page 46.

When the destination is a strategy table:
• All of the values in the source data must have the same data type (string, 32-bit integer, 64-bit integer, or 

float), and that data type must match the data type of the destination strategy table. (In other words, 

Here’s the data that was sent 
to the different variables.

Heartbeat interval
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send string data to a string table, float data to a float table, 32-bit integer data to a 32-bit integer table, 
and 64-bit integer data to a 64-bit integer table.)

• The number of values in a record of source data—including empty values in string data—must equal the 
range of elements in the destination field.
You can configure this in two ways: Configure one destination data item for each value of source data, or 
configure one destination data item that consists of consecutive elements in a range. 
For example, both of these configurations send values to the third, fourth, and fifth positions in a strategy 
table:
Configuration 1

Configuration 2

• There is no hard limit on the number of items that can be transferred on a link.
• When transferring data from a database to a strategy table, keep the following in mind:

– The data being transferred cannot contain null values. (Note that empty string values are 
supported.) 

– OptoDataLink can send data from individual database table columns to strategy tables. Just 
remember that the data type of each column must match the data type of its corresponding 
strategy table. For example, if a database table has a string column, an integer column, and a float 
column, you can send the data to a corresponding string table, integer table, and float table in the 
destination device.

– The number of rows in the database table (including rows with empty values) must be less than or 
equal to the number of elements in the destination strategy table. 

– If your database table has spaces in its name, rename it using underscores ( _ ) instead of spaces. 
OptoDataLink does not allow spaces in database table names or column names.

NOTE: For answers to common issues, “A: Troubleshooting” on page 63.
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In this image, the destination is a table in a PAC Control strategy:

This image shows the example output:

To configure a strategy table as the destination:
1. In the “and goes to a” drop-down list, select Opto 22 Device.
2. Click Add Tags.
3. In the Open Browser Items File dialog box, browse to folder that contains the .idb or .otg file you want. 
4. Click the file to select it, and then click Open.

The Select tags window opens.
5. Click the check box next to table you want to use, and then click Add Tags.

Click Details to set the heartbeat 
interval.

Move table up

Delete table

Move table down

Communication strings include the destination's IP address, port 
number, data type, and tagname. 

Click here and type the communication string 
to manually add a table.

Write to data items list
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If you have a choice between a table in a Direct folder and a table in an Indirect folder for an I/O unit, 
typically you would choose the table in the Direct folder because it has a direct connection to the I/O unit 
and is faster. 
An indirect connection goes through the controller, which slows down the connection. However, there 
may be times when you have to choose a table in the Indirect folder, such as:
– When the I/O unit is a serial brain that’s not connected directly to your PC.
– When the network that connects the controller and your computer is different from the network 

that the I/O unit is on.

NOTE: There is no hard limit on the number of items that can be transferred on a link.

To change how often OptoDataLink checks the scanner:
1. Click Details.
2. Enter a new value for the heartbeat interval.

3. Click Save to close the OPC Details dialog box.

To add a device table manually:
1. Click in the empty field at the bottom of the Write to data items list.
2. Type a complete communication string, and then press Enter. 

To manually edit a device table, simply type over the communication string.

Heartbeat interval
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SQL SERVER AS THE DESTINATION

For important information about configuring databases in a data link, see:
• “Configuring Databases” on page 25
• “Databases as the Destination” on page 29

To configure SQL Server as the destination:
1. In the “and goes to a” list, select Database.
2. In the Database Product list, select your version of SQL Server.
3. If your connection is a default instance, follow the instructions for A, B, C, E, F, and (optionally) G.

If your connection is a named instance, follow the instructions for A, D, E, F, and (optionally) G. 

A Server Location: If your database is a default instance, type the server location. 
If your database is a named instance, type the server name and the named instance separated by a 
backslash. Example: servername\instancename
If you are using the SQL Server Express, type the server name and the database name separated by a 
backslash. Example: servername\SQLEXPRESS

B Database Name: Type the database name. For example, Weather

NOTE: When the source or destination is a SQL Server database object, don't type the "dbo." prefix that SQL 
Server automatically adds. For example, if your SQL Server table name is "dbo.Weather," simply enter 
"Weather" when typing the database table name in OptoDataLink.

C User Login / Windows Security: If your database uses SQL Server authentication, type the database 
username and password.
If your database uses Windows authentication, select Windows Security.

D Data Source Name: Select Data Source Name, and then select the DSN from the list.
E Test Database Connection button: When you click this button, OptoDataLink attempts to connect 

to the database using the connection settings you selected. This button does not test the table name 
or the order by column setting.

F Table Name: Type the name of the database table. The table name cannot include spaces.
If the database table has only one column of data, you can simply type the database table name.
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If the database table has more than one column, type the database table name, a period (as a 
separator), and the column name. 
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

G Database Columns: Be sure that the source data has been configured to send the data to the 
Date/Time Stamp, Index, Data, and (optional) Unique Id column. To add another column, click Add 
Column.
If you did not select the Send Unique Id option, delete the Unique Id column.
To add another column, click Add Column.

To configure conditions, see page 58.

MYSQL AS THE DESTINATION

For important information about configuring databases in a data link, see:
• “Configuring Databases” on page 25
• “Databases as the Destination” on page 29

To configure MySQL as the destination:
1. In the “Data comes from a” list, select Database.
2. In the Database Product list, select MySQL.
3. In the MySQL Version field, select your version of MySQL.
4. If your connection is via a network or local computer, follow the instructions for A, B, C, E, F, and 

(optionally) G.
If your connection is a DSN, follow the instructions for D, F, and (optionally) G. 

A Server: If the database is on a local drive, select This Computer. If the database is on a network, type 
the file path to the database.

B Database: Type the database name. For example, Weather
C Database User and Password: Type the database user name and password.
D Data Source Name: Select Data Source Name, and then select the DSN from the list.
E Test Database Connection button: When you click this button, OptoDataLink attempts to connect 

to the database using the connection settings you selected. This button does not test the table name 
or the order by column setting.
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F Table Name: Type the name of the database table. The table name cannot include spaces.
If the database table has only one column of data, you can simply type the database table name.
If the database table has more than one column, type the database table name, a period (as a 
separator), and the column name. 
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

G Database Columns: Be sure that the source data has been configured to send the data to the 
Date/Time Stamp, Index, Data, and (optional) Unique Id column. To add another column, click Add 
Column.
If you did not select the Send Unique Id option, delete the Unique Id column.
To add another column, click Add Column.

To configure conditions, see page 58.

MICROSOFT ACCESS AS THE DESTINATION

For important information about configuring databases in a data link, see:
• “Configuring Databases” on page 25
• “Databases as the Destination” on page 29

To configure Microsoft Access as the destination:
1. In the Database Product list, select Access.
2. In the Access Version list, select your version of Access.
3. Follow the instructions for A, B, C, and (optionally) D.

A Database Location: Click the Browse button to locate the Access database folder. Then select the 
database and click Open.

B Test Database Connection button: When you click this button, OptoDataLink attempts to connect 
to the database using the connection settings you selected. This button does not test the table name 
or the order by column setting.

C Table Name: Type the name of the database table. The table name cannot include spaces.
If the database table has only one column of data, you can simply type the database table name.
If the database table has more than one column, type the database table name, a period (as a 
separator), and the column name. 
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

D Database Columns: Be sure that the source data has been configured to send the data to the 
Date/Time Stamp, Index, Data, and (optional) Unique Id column. 
If you did not select the Send Unique Id option, delete the Unique Id column.
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To add another column, click Add Column, and then type the column name.

To configure conditions, see page 58.

ODBC-COMPLIANT APPLICATIONS AS THE DESTINATION

For important information about configuring databases in a data link, see:
• “Configuring Databases” on page 25
• “Databases as the Destination” on page 29

To configure an ODBC-compliant application as the destination:
1. In the “and goes to” list, select Database.
2. In the Database Product list, select ODBC databases.
3. In the Driver list, select the driver for the database you’re using, and then click Configure Driver. 

OptoDataLink prompts you for the information it needs (such as the server location, file path, or login 
credentials) to construct a connection string to the database. If necessary, you can edit the connection 
string.

4. Click the Test button to see if OptoDataLink can to connect to the database.
5. In the Table Name field, type the name of the database table. The table name cannot include spaces.

If the database table has only one column of data, you can simply type the database table name.
If the database table has more than one column, type the database table name, a period (as a separator), 
and the column name.
Example: WEATHER.CITY (where the table name is WEATHER and the column name is CITY.)

6. In the Database Columns area, be sure that the source data has been configured to send the data to the 
Date/Time Stamp, Index, Data, and (optional) Unique Id column. 
If you did not select the Send Unique Id option, delete the Unique Id column.
To add another column, click Add Column, and then type the column name.

To configure conditions, see page 58.

ODBC Example: Excel as the Destination

The following steps use Excel and its ODBC driver as an ODBC-compliant data destination.

NOTE: The Single Sample option (see page 37) is not applicable to Excel. Excel always appends data.

Steps in Excel:
1. In Excel, open the Excel file you want to write to.
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2. Define a “named range” that consists of only one row containing the column names. 
When OptoDataLink writes data to the Excel workbook, it uses this row as the header row. Note that the 
column names cannot contain spaces.
a. Highlight the column names in the row, right-click, and then choose Define Name to open the New 

Name dialog box.
b. In the Name field, type a name for the named range. This name will be the database table name, so 

follow the same guidelines for naming a database table; namely, don’t use spaces or reserved words 
(see page 67) in the name. 

c. In the Scope list, select Workbook, and then click OK.

d. Click OK to close the New Name dialog box.
If a Microsoft privacy error is displayed, follow the instructions in the message to disable privacy for 
the workbook. 

3. Save and close the workbook.

Steps in OptoDataLink:
1. Open an OptoDataLink project, create a new data link, and configure a source. In this example, a text file 

is the source.
2. In the “and goes to” list, select Database.
3. In the Database Product list, select ODBC databases.
4. In the Driver list, select a Microsoft Excel driver. If there is more than one Excel driver, choose the driver for 

the version of Excel you are using. (If you’re not sure which driver to use, check with your DBA.) 
In this example, we’re using Excel 2010, so we select Microsoft Excel Driver (*.xls, *.xlsx, *.xlsm, *.xlsb).

5. Click Configure Driver. Select the version of Excel you are using (to find the version number, in Excel, 
choose Home > Help), and then click Select Workbook.

6. In the Select Workbook dialog box, browse to the workbook and select it. 

NOTE: Be sure that Read-Only is not selected. Otherwise, OptoDataLink can’t write data to the file.

Named range to represent table and columns 
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7. Click OK to close the Select Workbook dialog box, and then click OK to close the ODBC Microsoft Excel 
dialog box. 

8. Click the Test button to see if OptoDataLink can to connect to the workbook.
9. In the Table Name field, type the name of the range you defined in Excel. 
10. For each element in the source, configure a column to hold the data. 
11. Run the data link.

In this example, our configured data link looks like this:

Select the 
version

Click Select 
Workbook

Select the file

Unselect 
Read Only

The source file has four 
elements, so we 
configured four columns 
for the spreadsheet.
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And our Excel worksheet destination looks like this:

CONFIGURING CONDITIONS

Conditions define when and how often data exchanges happen. Each data link has its own set of conditions; 
that way, you can configure different conditions for different data links.

“when” 

You configure “when” conditions to control at what time or how often data exchanges take place. The default 
“when” condition exchanges data at 10 second intervals. There are two options for “when”:
• Interval: Use Interval to control the frequency of data exchanges. To configure the interval, type a 

number in only one of the interval fields (Hours, Minutes, Seconds, or Milliseconds). Leave zeros ( 0 ) in 
all the other interval fields.
– Use the largest unit available. For example, to set an interval of 1 minute, you type “1” in the Minutes 

field.” (In other words, don’t type 60 in the Seconds fields).
– The smallest interval you can configure is 100 milliseconds.
– Minutes and seconds have a limit of 59 for their highest values.
– Milliseconds field is in increments of 100 milliseconds. Type “1” for 100 milliseconds, “2” for 200 

milliseconds, and so forth.
• Time of Day: Use Time of Day to type the exact time to exchange data. With Time of Day, data is 

exchanged only once per day at the configured time. (Noon is 12:00:00 PM. Midnight is 12:00:00 AM.)

“when” condition

“depending on” condition



OptoDataLink User’s Guide 59

“depending on” 

“depending on” conditions define events that start the process of data exchange. There are five “depending 
on” options:
• Always: Data exchange begins at the configured “when” condition (for example, when the Time of Day is 

1:00 PM) and continues as long as OptoDataLink is running. 
• Not Yet: This option prevents the data link from exchanging data. Use this option, for example, when 

your project has multiple data links, and you want to prevent some of them from running when you click 
the Save and Start All Links button on the toolbar.
Note that when you start the data links in your project, OptoDataLinkRuntime evaluates the configured 
sources and destinations—even if their condition is Not Yet. If something is wrong with a data link’s 
configuration, the data link will have an Error status. This gives you a chance to fix the “Not Yet” data link’s 
configuration before you try to use the data link to exchange data.

• Opto 22 Device: Data is exchanged when OptoDataLinkRuntime evaluates the value of a configured tag 
as True. The value can be from a numeric variable, a digital point, or a single bit. When the value is not 
zero, OptoDataLinkRuntime Data interprets the value as True and exchanges data. Data is not exchanged 
when the value is 0 (zero), which OptoDataLinkRuntime interprets as False.

NOTE: To use a single bit, you must first select the variable that has the bit you want, and then manually enter 
the bit number. Bit numbering starts at 0 (least significant bit). For example, a 32-bit integer tag named myInt 
would be shown as: I32;Value.2;myInt The “.2” indicates the third bit of the variable.

To configure “depending on Opto 22 Device”:
a. Click the Edit button.
b. In the Open Browser Items File dialog box, browse to the folder that contains the .idb or .otg file you 

want.
c. Click the file to select it, and then click Open. The Select tags window opens.
d. Click the check box next to the tag you want, and then click Add Tag. 
e. Configure how often to exchange data when the value is True. For details, see “Configuring How 

Often to Exchange Data When the Value Is True” on page 60.
f. Type the frequency in milliseconds that OptoDataLinkRuntime should evaluate the tag (or bit).

• Database: Similar to the Opto 22 Device option, data is exchanged when OptoDataLinkRuntime 
evaluates the value of a record in a database table as True. The column’s data type must be numeric (not 
a string). When the value is not zero, OptoDataLinkRuntime interprets the value as True and exchanges 
data. Data is not exchanged when the value is null or 0 (zero), both of which OptoDataLinkRuntime 
interprets as False.

OptoDataLinkRuntime transfers data when the value of this tag (or bit) is not 0 (zero).

Edit button

Interval to check the 
tag (or bit)
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To configure “depending on Database”:
a. Click the Database Product button.
b. Enter the required information to connect to the database of your choice. For details, see 

“Configuring Databases” on page 25.
c. In the Table name field, type the table name.
d. In the Column name field, type the column name.
e. Configure how often to exchange data when the value in the database column is True. 

For details, see “Configuring How Often to Exchange Data When the Value Is True” on page 60.

• Combination: With this option, data is sent from the source to the destination based on the 
combination of “depending on” conditions. Using Boolean logic (Either/Or or And), you decide what 
conditions must be True before data is exchanged. 
For example, you can send the data when both values are True, or you can send it when only one of the 
“depending on” conditions is True. 
And because the Combination option can be used within another Combination, you can have multiple 
levels of conditions to control when the data is sent. For example, you could use create a combination 
that updates a variable in your controller when condition A and B are True—or if condition C is True. 

Configuring How Often to Exchange Data When the Value Is True

This configuration enables you to collect data repeatedly or to collect it just once, based on the value of a tag 
(or bit) in an Opto 22 device, or the value in a database table.

• Check One data exchange when the value is true to exchange data once when the “depending on” 
condition is True (not zero). OptoDataLink reads the condition tag at each monitoring interval. 
– If the condition is True and “One data exchange when the value is True” is selected, OptoDataLink 

sends data to the destination once.
– If the condition is True and “One data exchange when the value is True” is not selected, 

OptoDataLink sends data to the destination at each “when” time (interval or time of day) until the 
condition tag is False. (For details about “when” times, see “when” on page 58.)

OptoDataLinkRuntime transfers data when the data in this column is not 0 (zero).

Test Database 
Connection button

If this box is selected, 
OptoDataLink sets the value 
in the Opto 22 device to False 
after exchanging data. 

If this box is selected, OptoDataLink sends data 
only once when the condition is True. 

“Monitoring interval” is how often OptoDataLink checks the 
value in the Opto 22 device to see if it is True.
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Reset Value
– If the “depending on” device is an Opto 22 device, check Reset Opto 22 device value to reset the 

value of the tag or bit in the Opto 22 device to 0 (zero). This is an easy way to prevent the data from 
being sent again until the condition becomes True again.

– If the “depending on” device is a database, check Reset Database value to reset the value of all the 
data in the configured column to 0 (zero).

One example of how to use this feature is to record the end of a process. 
• Let’s say you have a data link that sends Product_Number and Weight from an Opto 22 device to a 

database table. 
• Each time a part is successfully manufactured, the Product_Number and Weight values are updated, and 

another tag—Completed—is set to 1 (which in this case means True).
• You configure a “depending on” condition that reads the value of the Completed tag. You also check the 

“One data exchange when the value is true” check box and the “Reset Opto 22 device value” check box.
• At the scheduled monitoring interval, OptoDataLinkRuntime reads the Completed tag. If the value is True, 

the data is sent to the database and the value is reset to False. This means data won’t be written to the 
database again until the next part is successfully manufactured (that is, when the Completed tag is once 
again True).
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Appendix A

A: Troubleshooting 

Use this Appendix for troubleshooting help. It includes the following sections:

“Troubleshooting Questions and Answers” (below)

“Problems with Your Database” on page 66

“Error Messages” on page 67

“Errors from the Driver” on page 68

“Status Messages from OptoDataLink Monitor” on page 69

“Data Quality Messages” on page 70

“Additional Troubleshooting Topics” on page 71

TROUBLESHOOTING QUESTIONS AND ANSWERS

Is the Service running?

For OptoDataLink to transfer data, the OptoDataLinkRuntime service must be running.

Normally, OptoDataLinkRuntime starts when the computer running OptoDataLink boots up, and stops when 
the computer shuts down. However, if OptoDataLinkRuntime unexpectedly stops (or fails to start), both 
OptoDataLink and OptoDataLink monitor provide visual cues to notify you.

Banner Notification

If you have OptoDataLink open when the OptoDataLinkRuntime service stops running, you’ll see a bright red 
notification banner in OptoDataLink, and a message box giving you advice on what to do. The banner remains 
visible in OptoDataLink until the service is restarted.
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If you are running OptoDataLink with Administrator privileges, you can click OK in the message box to attempt 
to start OptoDataLinkRuntime.

If you aren’t running OptoDataLink as an administrator, the message instructs you to:
1. Save your project and close OptoDataLink.
2. Start OptoDataLinkRuntime.
3. Restart OptoDataLink

To start OptoDataLinkRuntime:
1. Open Windows Task Manager and click the Services tab (or start Windows Services).
2. Find OptoDataLinkRuntime in the list of services, right-click it, and then click Start.

If the service stops as soon as you start it, delete the runtime.xml file from the computer’s 
C:\Program Files (x86)\Opto22\PAC Project 10.2 folder, and then reboot your computer.

OptoDataLink Monitor Icon

Whether or not OptoDataLink is open, the OptoDataLink Monitor icon in the Windows Notification area (the 
lower right side of the taskbar) changes when the OptoDataLinkRuntime service fails.

An “x” appears on the OptoDataLink Monitor icon (displayed in the notification area of the Windows taskbar), 
and a message is displayed when you hover your mouse pointer over the icon. 

A banner appears if OptoDataLinkRuntime fails to start or unexpectedly stops.

This is the message that appears if you are running OptoDataLink with Administrator privileges.

Hover the mouse pointer over the OptoDataLink Monitor icon to 
display the Link Status (page 23)
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If you’re running OptoDataLink with Administrator privileges, you can right-click the icon to display a pop-up 
menu that will let you try to restart the service.

Otherwise, you can follow these steps (described in the previous section) to try to restart it.

Is OptoDataLink’s scanner running?

If you are getting data from or sending data to an Opto device, does OptoDataLink’s scanner start up when 
you run the data link?
1. In Task Manager, click the Processes tab.
2. Select the “Show processes from all users” option at the bottom of Task Manager.
3. Check and see if OptoOPC.exe is running under the SYSTEM User Name.

Does the Test Connection button work?

1. In OptoDataLink, click the Test Connection button to the right of your database settings.
2. If the test does not work and you receive a Microsoft error, search the web for that error message to find 

what's wrong with your database settings.

Does a bad link work if you send the data to a text file?

Text files can fail in only two ways:
• The text file is on a remote machine.
• The text file has permissions set to prevent writing.

If a text file works, the problem is with the destination. You can also see in the text file what data it was trying 
to send. Writing to a text file automatically adds the date and time, so that part is not coming from the data 
source.

PROBLEMS DUE TO MICROSOFT FAST STARTUP/FAST REBOOT

Windows 10’s Fast Startup (called Fast Boot in Windows 8) is a default Windows setting that helps computers 
boot up faster. 

When Fast Startup/Fast Boot is enabled, Windows does not perform a fresh boot when you start your PC. 
Instead, it reuses some information about Windows that it saved when you shut down the PC.

The Start and Stop 
OptoDataLinkRuntime Service menu 
options are displayed only when you’re 
running OptoDataLink Monitor as an 
Administrator.
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Some applications (including PAC Display, OptoOPCServer, OptoDataLink, and SoftPAC) need a fresh boot up 
to properly function and communicate with other applications. When Fast Startup/Fast Boot circumvents this 
process, you may see issues such as these:
• Windows reports an error reading or finding a DLL file.
• Communication failures ("Cannot connect to scanner" errors) may prevent PAC applications from reading 

or updating tag values.

To resolve the issue, disable Windows Fast Startup/Fast Boot, and then restart the computer in order to get a 
fresh start. 

Another solution that sometimes works is to uninstall PAC Project, reboot the computer, and then reinstall 
PAC Project.

For more information, see OptoKnowledgeBase article KB87235, Windows Fast Startup (Fast Boot) can cause 
issues. 

PROBLEMS WITH YOUR DATABASE

Is the database on a remote machine?

OptoDataLink cannot read or write to Microsoft Access databases and some ODBC-compliant databases on 
remote computers. This is a limitation imposed by a Windows service used by OptoDataLink. However, 
OptoDataLink can write to remote SQL Servers, remote MySQL databases, and some remote ODBC-compliant 
databases. (See the ODBC driver’s documentation regarding remote access.) If you’re still having a problem 
with a database on a remote computer, use the Microsoft ODBC Data Source Administrator (32-bit) utility to 
make sure the correct driver is installed on the computer that’s running OptoDataLink. 

To start the Microsoft ODBC Data Source Administrator (32-bit) utility:
1. Press the Windows Start key, type Microsoft ODBC Data Source Administrator 

(32-bit) and then press Enter. 
2. In the Microsoft ODBC Data Source Administrator (32-bit) utility, click the Drivers tab.
3. In the ODBC Drivers list, find a driver for your database. 

For example: MySQL ODBC 5.1 Driver is for MySQL databases.

Is OptoDataLink writing a value to all of the columns in the database table?

OptoDataLink doesn’t have to write a value to all of the columns in a database table. However, for columns in 
the database table that OptoDataLink doesn’t set, you need to set up a default value. For information on how 
to do this, see the user documentation for your database.

http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=3252
http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=3252
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Does a column name start with a reserved word?

If you use a reserved word to name a column name in your database, OptoDataLink Runtime displays an error 
message. Avoid using these words to start a column name:

ERROR MESSAGES

This section describes some error messages you might see in OptoDataLink.

OPC_Quality_Last_Usable (Possibly be a QNAN?). OptoDataLink is trying to write a QNAN to the 
database. If you see this error, make sure that the column in your database table allows nulls or has NULL as 
the default value.

Error in <link name>: NULL database table element at index <index number>.  This error 
occurs when OptoDataLinkRuntime tries to write a null value from a database table to a strategy table. Null 
values are not supported. (Note that empty string values are supported.) 
To resolve this issue, you (or your DBA) can manually or programmatically replace null values in the source 
database table with non-null values.

Object cannot be stored in an array of this type.  The source and destination data types do not 
match. Ensure that data type of the source data matches that of the destination; for example, send string data 
to a destination that can store strings, and numeric data to a destination that can handle the particular type of 
numeric data.

ERROR <error code> Not a valid file name. A source or destination text file name or tagname is 
misspelled. If the source or destination is a database, the table name or column name is either misspelled or 
contains a space.

Column Name is not allowed.  The first characters of the column name are a SQL reserved word (such as 
alter, select, and truncate). OptoDataLink does not allow reserved words as the first characters of a 
column name. For example, UpdateMe is not allowed, but MyUpdate is acceptable.

The requested file <file name> could not be accessed. Reason: Could not find a part of the 
path <path and file name>.  The (source or destination) text file or Microsoft Access database is located 
on a network instead of being on the same computer as OptoDataLink. OptoDataLink cannot read or write to 
remote text files, Access databases, and some ODBC-compliant databases; this is a limitation imposed by a 
Windows service used by OptoDataLink. 

Note that OptoDataLink can write to remote SQL Server databases, remote MySQL databases, and some 
remote ODBC-compliant databases. To find out if your ODBC driver support remote access, see the OEM’s 
documentation.

Incorrect number of columns selected. Attempted to insert <x> items into <y> columns. The 
number of values in the source is not the same as the number of columns you have configured in the 
destination. 

alter delete having rename transaction

begin drop insert revoke truncate

by from join rollback update

commit grant merge select where

create group order start work
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Transaction failed. No rows updated in table: <table name>. Possible causes: the connection 
does not exist or is not open. You will see this message when any of these conditions exist:
• The connection to the database has been lost.
• The name or DSN in the OptoDataLink configuration is not correct.
• You have configured the same destination column more than once in the data link.
• The table name or a column name is not spelled correctly. (Table and column names may be 

case-sensitive, depending on the database.)

Object Reference Not Set To Instance of Object. This error message usually indicates a network 
connectivity issue which can be caused by the following common problems:
• Improperly connected cables
• A wireless network adapter switch that’s not enabled
• WEP, WPA, or WPA2 security key or passphrase issues
• Packets dropped over a lossy connection
• Network connection settings
• Incompatible or corrupted drivers

False values in cache. This error usually appears only when a link is started. It means that OptoDataLink 
queried for values before the source had time to send them, which can happen over a slow connection. It is 
not a fatal error and generally corrects itself in the next cycle.

Incorrect number of parameters. The number of values you’re writing doesn’t match the number of 
database columns you’re writing to. For example, this error would appear if you were reading five tags but 
trying to write to only four MySQL columns.

Incorrect number of values. This error is similar to “Incorrect number of parameters.” In this case, the data 
is being written to an Opto 22 device. It would appear if you were reading ten items from a database and 
writing to only eight tags.

The list of controllers cannot be read from the strategy file. If you get this error when using the 
OptoOPCServer Browser or when using OptoDataLink to browse a strategy to pick a tag, this means that an 
older version of PAC Project was installed after installing a newer version.

Each version of PAC Project is installed to a separate directory so that they can all coexist. However, certain files 
are used in common between all versions. This includes OptoOPCServer and the tag browsing portion of 
OptoDataLink. These applications use the most recently installed versions of those files.

To solve this problem, re-install the most current version of PAC Project. You do not have to uninstall the older 
version first.

ERRORS FROM THE DRIVER

Any error message that starts with a driver name in brackets is from the driver, not OptoDataLink. (An ODBC 
driver is a program that controls how your computer interacts with a database.) For example, 
"[Microsoft][ODBC SQL Server Driver][DBNETLIB]SQL Server does not exist or access denied" is an error from 
the SQL Server driver. This kind of error usually indicates that the driver is not installed correctly, or the server is 
not configured correctly. First, reinstall the driver and see if that fixes the problem. If it does not, make sure that 
your database server (that is, the computer that the database is running on) can handle requests over TCP/IP.
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STATUS MESSAGES FROM OPTODATALINK MONITOR

OptoDataLink Monitor provides information about the status of your data links. Messages are displayed in the 
system tray area of the Windows taskbar. For more information about OptoDataLink Monitor, see page 69.

If OptoDataLink Monitor displays an “Unable to determine status” or “Unable to communicate with service” 
message for longer than a few minutes, perform these steps to try to reinitiate the data links:
1. Stop the OptoDataLinkRuntime service.

a. Start Windows Task Manager and click the Services tab.
b. In the Name column, find OptoDataLinkRuntime.
c. Right-click OptoDataLinkRuntime, and in the pop-up menu, click Stop.

2. Stop OptoDataLink Monitor. 
a. In the Windows system tray area, right-click the OptoDataLink Monitor icon.
b. In the pop-up menu, click Exit OptoDataLink Monitor.

3. Restart the OptoDataLinkRuntime service.
a. Start Windows Task Manager and click the Services tab.
b. In the Name column, find OptoDataLinkRuntime.
c. Right-click OptoDataLinkRuntime, and in the pop-up menu, click Start.

4. Restart OptoDataLink Monitor.
• In Windows 10, click the Windows Start button, and then click Opto 22 > OptoDataLink Monitor 10.2.
5. Reload and run the project.

a. Right-click the OptoDataLink Monitor icon (in the Windows system tray area) to display its pop-up 
menu.

b. In the pop-up menu, click Start All Links to restart the data links from the most recent project. 
If you don’t want to start the most recent project, in the pop-up menu you can click Start OptoDataLink 
Configurator, and then reload and run the project you need. 

Message Meaning

X links running, Y links in error

X shows the number of links running.
Y shows the number of links in error. 
If no links are in error, Y will be 0 (zero).
NOTE: When you start the data links in your project, OptoDataLinkRun-
time evaluates the configured sources and destinations—even if their 
condition is Not Yet (meaning that data is not being exchanged). If 
something is wrong with a data link’s configuration, the data link will 
have an Error status. This gives you the chance to fix the “Not Yet” data 
link’s configuration before data is exchanged.

No links are running
The OptoDataLinkRuntime service is running, but there are no links 
running. This is the typical state when you haven’t started a link or you 
are in the process of configuring a link.

Service is not running
The OptoDataLinkRuntime service has stopped. Normally, the service 
starts when you start Windows, but if something stops it, you can 
restart it. For instructions, “Is the Service running?” on page 63.

Unable to determine status
OptoDataLink Monitor can communication with the OptoDataLinkRun-
time service, but it could not retrieve information about the status of the 
data link. 

Unable to communicate with service
OptoDataLink Monitor cannot communication with the OptoDataLink-
Runtime service.
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DATA QUALITY MESSAGES

OptoDataLink’s scanner provides data quality messages from configured devices. A value returned from an 
input or output point includes the value, data quality, and time stamp. This section explains the data quality 
messages, which may be a text string, decimal, or hexadecimal value as shown in the following table: 

OPC_QUALITY_BAD. If previously the scanner was able to successfully scan the tag, and now it can’t, the 
quality may be set to OPC_QUALITY_BAD. This occurs when a float value is a NAN (not a number). This can 
occur:
• With an analog value, when the analog module is not accessible to the brain for the rack it is mounted 

on. Check the voltage at that rack to make sure it is 5.00 to 5.20 VDC.
• When reading a floating point variable from the controller. A floating point variable is typically a NAN 

when:
– A NAN analog point is moved to the floating point variable; or
– There was a “divide by zero” error in the strategy logic. 

OPC_QUALITY_COMM_FAILURE. The scanner tries to connect to the appropriate device to obtain data 
for the tag. If it cannot connect, the quality is set to OPC_QUALITY_COMM_FAILURE. The scanner will keep 
trying to connect, but the quality will remain at OPC_QUALITY_COMM_FAILURE until it connects. 
OPC_QUALITY_ COMM_FAILURE could be caused by the following:
• A unit is not powered up.
• The Ethernet cable is not connected.
• The network is down.
• A hub/switch/router is offline.

OPC_QUALITY_DEVICE_FAILURE. If the connection to the device is good, but either the device is busy 
or the tag is undefined at the device, the quality changes to OPC_QUALITY_DEVICE_FAILURE.

A device is busy when the controller's host ports have been locked temporarily, which may occur:
• During PAC Control strategy downloads
• While saving a strategy archive to the control engine (normally done in conjunction with a strategy 

download)
• While transferring files to the control engine using PAC Terminal
• While viewing control engine message queue messages via PAC Control or PAC Terminal

An undefined tag can be caused by a number of things: 
• The strategy could have been modified and some of the tags may have been deleted or renamed, and 

then the modified strategy downloaded to the controller. Trying to access those tags will result in 
OPC_QUALITY_DEVICE_FAILURE because the tags are undefined. 

Data Quality Description Decimal Hex

OPC_QUALITY_BAD 0 0x00

OPC_QUALITY_COMM_FAILURE 24 0x18

OPC_QUALITY_DEVICE_FAILURE 12 0x0C

OPC_QUALITY_GOOD 192 0xC0

OPC_QUALITY_LAST_KNOWN 20 0x14

OPC_QUALITY_NOT_CONNECTED 8 0x08

OPC_QUALITY_OUT_OF_SERVICE 28 0x1C

OPC_QUALITY_LAST_USEABLE 68 0x44
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• The tag name is misspelled. All tag names are case sensitive, so if the tag name in the strategy is in 
lowercase, for example, and the client is using the tag name with all caps, then it will not match.

• The strategy was modified and one or more of the tags were renamed. 
• The strategy was cleared from the controller. 
• You are trying to read a table element beyond the end of the table.

OPC_QUALITY_GOOD. If the tag is scanned successfully, the quality changes to OPC_QUALITY_GOOD.

OPC_QUALITY_LAST_KNOWN. If a tag has been successfully scanned and then communication to the 
device is lost, the quality changes to OPC_QUALITY_LAST_KNOWN.

OPC_QUALITY_NOT_CONNECTED. When tags are added to the scanner, the quality is set to 
OPC_QUALITY_NOT_CONNECTED. Once the connection is established or fails, then the data quality is 
updated and will never return to OPC_QUALITY_NOT_CONNECTED for this connection. This initial attempt to 
connect may take a while, during which time the quality stays at OPC_QUALITY_NOT_CONNECTED. Every 
item quality is set to this when the item is first added, and there is no other use of this quality code.

OPC_QUALITY_OUT_OF_SERVICE. This message occurs when a value is requested for an item that is not 
active or for an item whose group is not active.

OPC_QUALITY_LAST_USEABLE. This message occurs when the last value scanned is a NaN (not a 
number), which indicates that a floating point value is not valid. Typically, the value is related to an analog 
input point on an I/O unit in a situation where the brain could not communicate with the module. 

The most common cause of this is low voltage at the rack. The voltage (as measured downstream of the fuse 
on the rack) should be 5.00 to 5.20 VDC. If there is any AC ripple or noise, then the fluctuations should stay 
within the 5.00 to 5.20 VDC range. If you are using an adjustable power supply, we recommend adjusting it so 
that the voltage (as measured downstream of the fuse on the rack) is about 5.15 VDC.

This error can also be caused by a divide by zero operation in strategy logic.

ADDITIONAL TROUBLESHOOTING TOPICS

Cannot Connect to MySQL Database

If a “Could not connect to database” error is received when attempting to connect to a MySQL database, do 
the following:
1. Open the Windows Control Panel and go to Administrative Tools> Data Sources (ODBC).
2. Click the Drivers tab and look in the list of drivers installed on the client machine.
3. Is there one called "MySQL ODBC <version number> Driver?”

If the driver is not there, you'll need to install it so that Windows can connect to a remote MySQL 
database. If you do not have the driver, you can get it at
http://dev.mysql.com/downloads/connector/odbc/ 
Make sure to get the 32-bit version for your operating system.
However, if the ODBC driver for your version of MySQL is listed on the Drivers tab:
a. Click the System DSN tab.
b. Click the Add button, and then choose the MySQL Driver in the first page of the wizard.
c. Complete the wizard as directed.
d. To test the connection, in the MySQL configuration dialog in OptoDataLink, click the Test 

Connection button. If the test is successful, you can now connect to a MySQL database.

http://dev.mysql.com/downloads/connector/odbc/
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Using a DSN to Connect to the Database

Problem: When using a data source name (DSN) to connect to the database, the database is not listed.

Solution: Make sure that the DSN was set up as a system DSN—not a user DSN—using the 32-bit version of 
Microsoft’s ODBC Data Source Administrator utility. To verify this, start the utility, and then look for the 
database on the System DSN tab (Start key > Microsoft ODBC Data Source Administrator (32-bit) > System 
DSN tab).

Workarounds
• Don’t use the DSN to configure the data link. Instead, enter information in the Database Properties fields.
• When trying to use DSN Source Name, select File > Save. An XML file is created. Edit the resulting XML file 

and modify the following string with the name of the database:
<connection-string>DSN=TheirDatabaseName</connection-string>
Test the connection with the Test Connection button. You still may not see the database name in the 
drop-down list, but it should work.

OptoDataLink Is Behaving Like an Older Version

This is not likely to happen, but sometimes through a series of installs and uninstalls the 
OptoDataLinkRuntime service can point to an OptoDataLinkRuntime.exe file from an earlier installation of 
OptoDataLink. This causes OptoDataLink to behave as though it is an older version.

Do the following steps to determine which version of OptoDataLink the service is pointing to:
1. Open the Windows Control Panel and click Administrative Tools.

In Windows 10, 8.1, and 7, if the control panel is displayed by category, Administrative Tools is in the 
System and Security group.

2. Double-click Services.
3. Scroll down the list to find OptoDataLinkRuntime.
4. Right-click OptoDataLinkRuntime, and then choose Properties.
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5. On the General tab, look at the entry for “Path to executable.”
For example, a 9.5 installation should point to the 9.5 folder, not the 9.4 folder or something else. If it is 
pointing to the wrong folder or the path is incorrect, do the steps below for the Solution.

6. Click OK or Cancel.

Solution:

The solution is to stop the OptoDataLinkRuntime service, delete the service from the list, and then add the 
service again with the appropriate path.
1. In the Services window already open, highlight OptoDataLinkRuntime, and then click Stop.
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2. Open a command prompt, and change the directory to \Windows\System32 (unless you’re already in 
that directory).

3. Type the following command, and then press Enter:
sc delete OptoDataLinkRuntime

4. Type the command for your operating system and then press Enter. Make sure to replace 9.x with the 
correct version of PAC Project:
For a 32-bit operating system
sc create OptoDataLinkRuntime binPath= "C:\Program Files\Opto22\PAC 
Project 9.x\OptoDataLinkRuntime.exe" start= auto

For a 64-bit operating system
sc create OptoDataLinkRuntime binPath= "C:\Program Files (x86)\Opto22\PAC Project 
9.x\OptoDataLinkRuntime.exe" start= auto

5. With OptoDataLinkRuntime highlighted in the Services dialog box, click Start.
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6. Close the open dialog boxes.
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